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Before you begin

6is learner guide is based on the unit of competency BSBITU303 Design and 
produce text documents, Release 1. Your trainer or training organisation must give 
you information about this unit of competency as part of your training program. 
You can access the unit of competency and assessment requirements at:  
www.training.gov.au.

How to work through this learner guide

6is learner guide contains a number of features that will assist you in your 
learning. Your trainer will advise which parts of the learner guide you need to 
read, and which practice tasks and learning checkpoints you need to complete. 6e 
features of this learner guide are detailed in the following table.

Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across content that 

is confusing, make a note and discuss it with your trainer. Your trainer 

is in the best position to offer assistance. It is very important that you 

take on some of the responsibility for the learning you will undertake.

Examples and 

case studies

Examples of completed documents that may be used in a workplace 

are included in this learner guide. You can use these examples as 

models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of 

workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones 

and other devices to access video clips relating to the 

content. For information about how to download a QR 

reader app or accessing video on your device, please visit 

our website: www.aspirelr.com.au/help

Summary Key learning points are provided at the end of each topic.

Learning 

checkpoints

There is a learning checkpoint at the end of each topic. Your trainer will 

tell you which learning checkpoints to complete. These checkpoints 

give you an opportunity to check your progress and apply the skills and 

knowledge you have learnt.
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Foundation skills

As you complete learning using this guide, you will be developing the foundation 
skills relevant for this unit. Foundation skills are the language, literacy and 
numeracy (LLN) skills and the employability skills required for participation in 
modern workplaces and contemporary life.

6e following table outlines speci=c foundation skills noted for your learning in 
this learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets textual information from 

a range of sources to determine and adhere to 

requirements

Writing  • Develops documents using required format, accurate 

spelling and grammar and terminology speci�c to 

requirements

 • Organises content to support purpose and audience of 

material using clear and logical language

Oral communication  • Uses speci�c and direct language, and listening and 

questioning techniques to clarify requirements 

Navigate the world of work  • Recognises and follows explicit and implicit protocols 

and meets expectations associated with own role

Interact with others  • Collaborates with others to achieve joint outcomes

Get the work done  • Uses advanced features within applications to address 

routine and complex work tasks
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Before you begin

What do you already know?

Use the following table to identify what you may already know. 6is may assist you 
to work out what to focus on in your learning.

Topic Key outcome Rate your con�dence 

in each section

Topic 1 Prepare 

to produce word-

processed documents

1A Use safe work practices  Con�dent

 Basic understanding

 Not con�dent

1B Identify and clarify the purpose, 

audience and presentation 

requirements of a document

 Con�dent

 Basic understanding

 Not con�dent

1C Identify requirements to ensure 

consistency of style and image
 Con�dent

 Basic understanding

 Not con�dent

Topic 2 Design word-

processed documents

2A Design the structure and layout of 

a document
 Con�dent

 Basic understanding

 Not con�dent

2B Design the document to enhance 

readability and appearance
 Con�dent

 Basic understanding

 Not con�dent

2C Ensure consistency of design and 

layout
 Con�dent

 Basic understanding

 Not con�dent

Topic 3 Add tables and 

other data

3A Insert a standard table into a 

document
 Con�dent

 Basic understanding

 Not con�dent

3B Insert and delete columns and 

rows
 Con�dent

 Basic understanding

 Not con�dent

3C Insert images and other data  Con�dent

 Basic understanding

 Not con�dent

continued …
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… continued

Topic Key outcome Rate your con�dence 

in each section

Topic 4 Produce text 

documents

4A Use advanced software functions  Con�dent

 Basic understanding

 Not con�dent

4B Enter, import and edit text and 

other data
 Con�dent

 Basic understanding

 Not con�dent

4C Preview, adjust and print 

documents
 Con�dent

 Basic understanding

 Not con�dent

4D Name and store text documents 

and exit the application safely
 Con�dent

 Basic understanding

 Not con�dent

4E Prepare text documents within 

designated time lines
 Con�dent

 Basic understanding

 Not con�dent

4F Overcome problems with 

document design and production
 Con�dent

 Basic understanding

 Not con�dent
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Topic 1 
Prepare to produce 
word‑processed documents

6is topic will take you through the process of preparing to produce word-
processed documents. Careful preparation is integral to the level of success of any 
activity. Imagine cooking a cake with no recipe and part way through discovering 
you have no eggs! Likewise in business, planning, research and gathering tools 
together will ensure a timely and successful outcome.

Preparation begins with a safe work environment and knowledge of good 
work practices. 6is topic introduces the value of policies and procedures in an 
organisation and the communication skills that ensure you are aware of your 
workplace’s expectations.

In this topic you will learn how to:

1A Use safe work practices

1B Identify and clarify the purpose, audience and presentation requirements of a 
document

1C Identify requirements to ensure consistency of style and image
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Workplace safety is everyone’s responsibility. Employers and employees must make 
an active contribution to ensuring their workplace is safe. Hazards need to be 
identi=ed and risks assessed to reduce injury in the workplace. If you are working 
at a computer for an extended period each day, your workstation must be 
comfortable and designed for you to carry out your tasks eCciently. You will need 
to organise your work so that you are not doing a repetitive task for a long time. 
You should also take time to stand up and stretch. 

Another consideration in the 
workplace is to use resource 
conservation techniques 
to prevent wastage. Most 
organisations require staE 
to follow resource-saving 
procedures such as turning oE 
lights in unused rooms and 
recycling paper. You need to 
be aware of any conservation 
eEorts made by your 
organisation.

Workplace safety legislative requirements

All work health and safety (WHS) legislation requires employers to provide 
a safe workplace and adequate training and supervision, while controlling 
workplace hazards and risks. You must work in line with legislative requirements, 
regulations, Australian and industry standards, and the relevant codes of practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe 
and healthy, such as:

• managing risks to health and safety

• promoting and maintaining the health, safety and welfare of people at work

• protecting people at work from injury and illness, including 
psychological injury

• protecting the health and safety of the public in workplaces

• consulting workers and encouraging participation in maintaining WHS

• providing rehabilitation and maximum recovery for injured workers.

1A Use safe work practices
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WHS policy 

All workplaces in Australia are required to have a WHS policy that describes the 
organisation’s responsibility for the health and safety of its employees. 6e policy 
should include the organisation’s goals and objectives regarding WHS and a 
general set of guidelines related to health and safety in the workplace.

6e WHS policy will help you ful=l your duty of care as a worker for the 
organisation.

WHS procedures

WHS procedures are instructions developed to ensure all employees work safely 
and eEectively. In the context of working in an oCce and using a computer 
workstation, the following information should be contained in an organisation’s 
WHS procedures.

Information contained in WHS procedures includes:

• workstation ergonomics

• standard safety precautions and housekeeping

• safe handling of hazardous substances (e.g. cleaning products)

• emergency and =re drills

• hazard identi=cation and risk control

• manual handling

• emergency contact numbers, including local doctors and hospitals

• location of =rst-aid equipment and =rst-aid oCcers.

WHS regulations 

6e WHS legislation of each state or territory is supported by regulations and 
codes of practice. 6e WHS regulations support the legislation by outlining 
speci=c workplace health and safety requirements that must be addressed.

6e Model WHS regulations, which provide a framework that most states and 
territories have adopted, have speci=c requirements for hazardous manual tasks 
that must be addressed. 6ese requirements are summarised below.

Manage risk

A person conducting a business or undertaking must manage 

risks to health and safety relating to a musculoskeletal disorder 

associated with a hazardous manual task, in accordance with 

guidelines for managing risks to health and safety.



4
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

Control measures

In determining the control measures to implement, the person 

conducting the business or undertaking must have regard to 

all relevant matters that may contribute to a musculoskeletal 

disorder, including:

 • postures, movements, forces and vibration relating to the 

hazardous manual task

 • the duration and frequency of the hazardous manual task

 • workplace environmental conditions that may affect the 

hazardous manual task or the worker performing it

 • the design of the work area

 • the layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of persons, animals or things 

involved in carrying out the hazardous manual task.

Code of practice: hazardous manual tasks

6e WHS regulations determine that it is a legal requirement for the person 
conducting a business or undertaking (PCBU) and workers to address hazardous 
manual tasks in the workplace. A PCBU has a broad de=nition that includes both 
employers and supervisors.

6e code of practice for hazardous manual tasks was developed to provide 
guidance on how to manage risks associated with those manual tasks with the 
potential to cause musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop 
their own set of procedures to manage the risk of MSDs.

6e hazardous manual tasks code of practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

Musculoskeletal disorders

MSDs come about in two main ways:

• Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs 
through repeated or continuous use of the same body parts, including static 
body positions

• Sudden damage caused by strenuous activity or unexpected movements, such 
as when loads being handled move or change position suddenly
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6e repetitive movements and sustained body position associated with entering 
data into a computer is regarded as a hazardous manual task and puts the operator 
at risk of developing an MSD. 

MSDs may include conditions such as: 

• sprains and strains of muscles, ligaments and tendons

• back injuries, including damage to the muscles, tendons, ligaments, spinal 
discs, nerves, joints and bones

• joint and bone injuries or degeneration, including injuries to the shoulder, 
elbow, wrist, hip, knee, ankle, hands and feet

• nerve injuries or compression (e.g. carpal tunnel syndrome)

• muscular and vascular disorders as a result of hand-arm vibration

• so0 tissue hernias

• chronic pain.

Standard precautions

Your workplace may need you to use standard 
precautions, particularly work practices related to 
the prevention of repetitive strain injuries (RSIs). 
6ese include ergonomic practices, workstation 
design, enforced breaks and exercise routines.

Workers in an oCce environment follow standard 
precautions when using a computer workstation. 
However, research on sitting has demonstrated 
that other precautions also need to be considered, 
such as the use of standing workstations, to 
ensure that injuries are prevented. It is important 
that you carefully follow any standard precautions 
that are prescribed for your workplace.

Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and 
equipment you will use during the day to make sure they are in correct working 
order. Your workplace policies and procedures should include the steps to follow. 
You may need to perform this procedure at the start of your working day or at 
speci=ed intervals during the day.

Workstation safety procedure/checklist:

• Seat is positioned in front of your computer and you can reach your keyboard 
comfortably.

• Computer monitor is positioned out of direct sunlight and at the correct 
height. 
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• Environment is dust-free as dust can aEect the monitor or central processing 
unit of a computer.

• Cables are secured so no-one trips over them.

• Blinds and window coverings are used to reduce glare and heat at your 
workstation.

• Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace

6e aim of ergonomics is to reduce the risk of 
accidents, injury and ill health by applying safe work 
practices. Ergonomics is about creating comfortable 
working conditions by adapting workstations, tools 
and equipment to an individual worker’s needs. It 
also improves performance and productivity in the 
workplace. Ergonomics covers all aspects of working, 
from physical stresses such as sitting at a workstation 
all day to environmental factors such as noise, air-
conditioning and lighting.

Set up your workstation

A workstation includes a computer, screen, keyboard, mouse, desk and chair. How 
your workstation is designed can aEect your health and wellbeing. Several physical 
problems can result from poor workstation design; for example, lower back strain 
may result from sitting  in a chair that does not support your back. Below are some 
guidelines for setting up your workstation to be ergonomically eCcient.

Chair

Adjust your chair height so that your feet are �at on the �oor, your 

thighs are horizontal and your lower legs are vertical to the �oor.

Adjust the backrest by raising it to the maximum height and 

then lower it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until a comfortable position is found. The backrest should support 

your lower back.

The backrest may also be adjusted backwards and forwards. 

When seated in your usual working position, move the backrest 

until it exerts a gentle pressure on your lower back. Make sure 

there is at least two centimetres of space between the front of the 

seat and the back of your knees. Armrests should be positioned so 

that they do not interfere with carrying out your tasks.
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Desk

When you sit at your desk, the surface should be just below your 

elbow height. If your desk is not height-adjustable, try to raise your 

chair so you are sitting at the correct height, and use a footrest to 

make up the difference. If your desk is too low, you may be able to 

extend the legs. You should have plenty of leg space underneath 

your desk. Don’t clutter the space with bags and bins, as your 

legs may become cramped and your posture twisted. Position any 

equipment or materials you use so that you can reach them easily 

without twisting. For example, stationery items you frequently use 

should go in the top desk drawer, and your keyboard and screen 

should sit directly in front of you to avoid having to angle or twist 

your body.

Keyboard

The angle of your keyboard can be adjusted to suit your comfort 

level by moving the supports underneath it. Place the keyboard as 

close as possible to the front of your desk. Don’t place documents 

between yourself and the keyboard, as stretching will eventually 

cause muscle strain in your arms, shoulders and neck. While 

typing it is best not to rest your wrists, as they should not be bent 

up, down, or to the side. The knuckle, wrist and top of the forearm 

should form a straight line. Wrist supports or rests give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; use a light touch. Leave enough 

room on your desk to put the keyboard out of the way when you 

are not using it.

Mouse

Place the mouse and mouse mat directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight, and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist �at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.
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Screen

Once you have adjusted your chair and desk, you can position 

your screen. Adjust it so that the top of the screen is level with or 

slightly lower than your eyes. If you can’t adjust the screen to the 

correct height, place the screen on a platform.

The screen should be at least 50 centimetres or an arm’s 

length away from your seated position to minimise radiation 

exposure; however, you should always adjust the position of the 

screen to suit you. It is best to position the screen so that you 

can clearly read the text without leaning forward, twisting your 

neck, or looking too far upwards. Also take surrounding factors 

into consideration, such as re�ection, glare and shadow, when 

positioning your screen.

Workstation features

6e features of an ergonomic workstation are highlighted in the diagram below. 
Some features of the workstation may vary depending on the type of computer 
work being performed. Graphic work may require the use of a pen tool, and 
multiple monitors are commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 

degrees to the horizontal. 

Centre of screen Minimise screen re�ection and glare by using an anti-glare �lter.

Bottom of screen Place a document holder beneath or beside the screen at the 

same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

continued …
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… continued

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 

your legs.

Below knee Ensure there is clearance between the front edge of the seat and 

the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 

back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a �ve castor base.

Desktop layout

Items on your desk, including equipment and resources, should be arranged 
within easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate 
most of the time

• the maximum reach zone – further away, but still close enough to reach 
comfortably

• the outer reach zone – where you may have to bend forward or stand to 
reach items.

Make sure your desk is organised so that frequently used objects, such as your 
keyboard, are close to you. Intermittently used objects, such as your phone, should 
be out of the way but still within easy reach. Other resources used less frequently, 
such as in- and out-trays, should be in the outer reach zone.
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Adjust your equipment and posture

When your posture is poor, you may suEer from aches and pains. Spending a long 
time in the same position can put stress on your body and this can be made worse 
if you are in an uncomfortable or poorly supported position. 6ese symptoms may 
start out very slight, but if you continue to use poor posture they may get worse 
and become intolerable. 6ey may result in cumulative stress given the constant 
stress on your muscles, nerves or tendons. When setting up your workstation, 
you need to make sure your posture will not cause you pain or discomfort. 6e 
equipment you use needs to be adjusted to suit your body shape and size, and the 
tasks you are doing.

You have already looked at adjusting your screen and chair. 6ere are other oCce 
tools that can help your posture. 6ese include the following items.

Document holders

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for long 

periods of time can cause headaches 

and eyestrain. Place the document 

holder at a similar level, angle and 

distance as the screen to avoid having 

to shift eye focus.

Angle boards

Angle boards allow the user to maintain 

correct posture when reading, by 

reducing the angle between the work 

surface and the vertical posture. 

Adjustable to a suitable height 

and angle, these supports enable 

comfortable reading with the neck 

correctly positioned. Try to keep your 

neck as straight as possible when you 

are reading.

Footrests

A footrest may be necessary if you can’t 

place your feet comfortably on the �oor. 

Footrests allow your feet to rest at the 

correct height and on a tilting angle, 

which prevents strain on the lower 

back. 

Headsets

If you use a telephone for long periods 

of time, it is a good idea to use a 

headset. A headset will keep your neck 

straight and your arms free. Headsets 

prevent you from bending your neck to 

support the telephone handpiece.

Home o5ce

Communication technology and organisational policies to maintain a 
sustainable work–life balance are creating opportunities for more Mexible 
working arrangements. 6is means that more employees are working from 
home oCces or in other remote oCce locations. Many bene=ts can be derived 
from Mexible working arrangement for employers and employees, but there is 
still a responsibility for all parties to make sure that home and remote oCces use 
ergonomic practices and follow WHS requirements.
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Hot desking

Hot desking is an oCce organisation system that is used in some workplaces where 
workstations are not assigned to an individual worker. Workstations may be used 
by multiple workers during diEerent time periods or shi0s. 

6e motivation behind hot desking is primarily the cost savings achieved by 
setting up fewer workstations in workplaces where not all the workers are in the 
oCce at the same time, or not in the oCce for long periods at a time. 

Another common adaptation of hot desking is where work stations are assigned 
to individual workers, but need to be readily available for other workers to access 
based on daily work requirements, such as a group of people coming together to 
work on a speci=c project.

WHS and workplace culture considerations with hot desking

 • It is common for workers to want their own space. Consequently, they may tend to 

choose one location and stick to it.

 • It can take extra time each day to set up a work station for ergonomic and work 

ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on keyboards 

and desk surfaces.

 • Workstations need to be tidied appropriately in readiness for the next user. This can 

also involve some cleaning.

Standing desks

Sitting at a desk for long periods of time has 
many negative health impacts. It is claimed that 
the negative eEects of prolonged sitting cannot be 
counteracted by regular exercise and that the only 
way to eliminate this problem is to avoid sitting as 
much as possible. 

6ese negative health impacts can be overcome 
through the use of standing desks. Standing 
provides a greater opportunity for your body to 
move and adjust and involves more muscular 
activity than sitting.

Some of the health bene=ts from standing 
include:

• alleviating back pain and other repetitive stress injuries by greater use of core 
back muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood 
clots, which can be caused by prolonged sitting.
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Standing desk ergonomics

Using a standing desk for hours on end requires you to adapt. It is recommended 
that you start using a standing desk gradually by alternating between sitting 
and standing. You may experience sore feet, tired legs and fatigue at =rst. Wear 
comfortable shoes and use an anti-fatigue Moor mat.

An ergonomically designed standing work desk means you can maintain correct 
posture while working. 

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight. 

Monitor environmental factors

Environmental issues in the workplace include lighting, noise control and air 
quality. If the environment of your workplace is not monitored and controlled, you 
may suEer from headaches, fatigue, hearing loss or eyestrain.

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see 
things clearly to work eEectively. Simply shi0ing the screen slightly, adjusting 
blinds, altering the brightness settings on the screen and using desk lamps can 
avoid many light hazards. Try to use natural sunlight if the oCce layout can 
accommodate this. If not, keep bulbs and =xtures clean, focus light on your task 
and use Muorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:

• glare – a computer screen positioned in front of a bright window can be 
diCcult to see

• Mickering lights – a Muorescent light may malfunction, causing annoyance, 
irritation and nausea

• inadequate or dim light – reading in dim light causes eyestrain

• reMections – sunlight reMecting on a screen can make it diCcult to read

• shadows – shadows shi0ing across your work area can cause you to sit with 
bad posture in order to read your work.
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Noise

Noise can include any annoying or disturbing sound. Excessive noise around 
heavy machinery or equipment can cause permanent hearing loss. Noise is a 
problem if it disturbs people, distracts them, interferes with communication, 
causes people stress or generally interferes with their work.

Many oCces are open-plan in design, o0en with employees seated close to each 
other and divided by partitions at chest or head height. 6ink about noise levels 
when you set up your workstation. It should be possible for people in open-plan 
oCces to have some privacy when they are on the telephone and carrying out their 
day-to-day activities.

Noise in the oCce can come from:

• machines (photocopiers, fax machines, printers)

• other equipment (telephones, paging systems, music)

• background noise (li0s, air-conditioning, traCc)

• people talking.

Noise management

Noise can also be a problem outside oCce environments, 
such as on factory Moors, at construction sites or near 
airports. You may have to wear ear protection if you are 
required to work in excessively noisy areas.

6ere are many ways that problem noise can be 
controlled in the workplace. Noisy machines can be put 
in a separate room or area. Sound-absorbent materials 
such as carpet and partitions can be installed or 
arranged to deMect and absorb noise. 6e volume level on your telephone’s speaker 
can be adjusted.

Remember that noise is only a hazard when it is stopping you from working 
productively, comfortably and safely. Many people prefer to work with low levels of 
noise rather than complete silence.

Air

Air-conditioned oCces do not have fresh air from open windows. 6is can cause 
problems for some people.

OCce workers frequently complain of being too hot or too cold. If a person’s desk 
is near an air-conditioning outlet, the area around their desk can be much colder 
than elsewhere in the oCce. 6ey can also suEer from dry and itchy eyes. Report 
such hazards to the relevant person. 6is situation can usually be corrected by 
adjusting air-conditioning Mow.
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Organise your work

Having a well-planned workstation and comfortable surroundings is pointless if 
you don’t organise your work in a way that prevents discomfort or pain. Make sure 
you plan your daily tasks so that you aren’t doing repetitive work for long periods 
of time. Make sure you take rest breaks and exercise regularly.

Positive work organisation includes:

• a mixture of repetitive and other activities

• rest periods

• exercise breaks.

Vary your activities

Your work role may involve several diEerent tasks. Some tasks may be repetitive, 
such as typing up reports or entering data. If you are able to vary the tasks you 
carry out each day, this will help prevent repetitive actions that cause stress to 
your body. For example, if you have to enter a lot of data, break up the repetitive 
nature of the task by discussing a project with a fellow worker, collecting some 
research from the internet or doing another constructive workplace task you are 
responsible for. WorkMow should be designed to reduce the repetitive tasks given 
to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include 
tea breaks and lunch breaks. During the working day everyone needs to sit down, 
breathe easily, relax and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular intervals 
to combat stress and prevent pain and discomfort. As discussed previously, using 
computers for too long without breaks has been associated with back and neck 
pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage 
others around you to try them. Make sure you are relaxed and 
stretch gently, without overstretching. Stop if you feel any pain 
or discomfort, and remember to exercise both sides of your body. 
Most importantly, breathe deeply and evenly throughout the 
stretch.

v1
3

2
3
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Neck Turn your head gently to look over your right 

shoulder. Hold for 10 seconds. Now roll your 

head forward to look over your left shoulder 

and hold for 10 seconds. Repeat several times.

Shoulders Sitting with a straight back and neck, roll your 

shoulders forward, then back. Repeat several 

times.

Wrists, hands and arms Interlacing �ngers, turn palms upwards. Now 

lift arms over your head and stretch, leaning 

gently to the left and then to the right. Repeat 

movement several times.

Upper and lower back In a standing position place hands in the small 

of the back. Gently arch back and hold for 10 

seconds. Repeat when needed.

Shoulders and arms Stretch your arms above your head, cradle 

your elbow with your hand and gently pull your 

elbow behind your head. Repeat on the other 

side, holding the stretch for 10 seconds.

Eyes Every 20 minutes, look away from the screen. 

Focus on a distant object (more than three 

metres away).
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Work without stress

Here are some tips for working without stress.

Tips to help minimise stress

 • Adjust your chair and desk to suit your body.

 • Position your screen to suit your posture.

 • Adjust other equipment for safe and comfortable use.

 • Reduce excess noise.

 • Ensure you have adequate light.

 • Arrange your desktop so you can access things easily.

 • Take regular breaks from your work.

 • Frequently rest your eyes.

 • Do stretching exercises.

 • Vary your tasks.

Practise conservation techniques

Conserving resources at work bene=ts not only the 
organisation by reducing costs, but also the planet by 
reducing greenhouse gases and the amount of waste 
sent to land=ll. Most organisations have policies and 
procedures for conserving resources. You can =nd out 
what these are by reading your workplace manual or 
asking your manager or colleagues.

Ways to conserve resources at work include:

• minimising paper wastage

• reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many 
organisations have developed policies for paper usage. 6ese include:

• using both sides of the paper when photocopying

• recycling non-con=dential waste paper in recycling bins

• storing email messages in an electronic folder instead of printing

• reducing the volume of printing where possible

• reusing paper by using blank sides for rough dra0s and reusing folders 
and =les

• using recycled paper or paper from plantation timber for printed documents

• using a recycling service to collect waste paper.
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Example: o5ce paper

Using the following statistics, consider how many trees are used for of�ce paper.

How many trees are used to produce paper?

 • One ton of uncoated virgin (non-recycled) printing and of�ce paper uses 24 trees.

 • One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

 • One ream (500 sheets) of paper uses six per cent of a tree.

 • One tree makes 16.67 reams of copy paper, or 8,335 sheets.

 • One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a 

tree.

 • One ton of coated, non-recycled higher-end 

magazine paper (used for high quality photographic 

magazines) uses more than 15 trees.

 • One ton of coated, non-recycled lower-end magazine 

paper (used for news magazines and most 

catalogues) uses nearly eight trees.

The statistics in this example are based on US short 

tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com 

Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many 
organisations have developed policies and procedures to save energy. 6ese 
include:

• providing training programs on smart energy practices so that employees can 
practise energy eCciency

• turning oE equipment when not in use

• using power-save functions for equipment

• re=lling toner and ink cartridges from printers.



18
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

Resource conservation

Here are some tips for practising conservation.

Resource conservation tips

 • Use the power-save function on printers when they are not in 

use.

 • Print and copy on both sides of the page, where possible.

 • Use recycled paper (paper used on one side) in the 

photocopier and printer for rough drafts.

 • Use recycled paper for telephone messages.

 • Place a recycling bin near the photocopier.

Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that 

are relevant to you and make any necessary adjustments to your work or study space. 

You may need another person to help you and check your posture. If you are not able to 

tick some of the checkpoints, change your study space or discuss making alterations to 

your workstation with your manager.

Chair

 � Is the seat height-adjustable?

 � Is it high enough to allow you to sit comfortably over the keyboard?

 � Is it stable?

 � Does it swivel?

 � Is the height of the backrest adjustable and does it tilt backwards and forwards?

 � If it has arms, can you still get close enough to the desk and swivel the chair?

 � Are your feet �at on the �oor, or are you using a footrest?

 � Are you sitting up straight with the backrest �rm against your back?

Desk

 � Is it large enough to allow the screen and keyboard to be correctly positioned?

 � Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

 � Is it high enough to allow your thighs to �t underneath it?

Keyboard

 � Can it be tilted to allow you to adjust it?

 � Are the symbols on the keys clear and easy to see?

 � Is there suf�cient space in front of it to allow you to correctly position your arms?

Screen

 � Does the screen have easily adjustable brightness and contrast controls?

 � Is the image on the screen stable and �icker-free?

 � Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised 

to avoid glare and re�ections and help you keep a natural and relaxed posture?

 � Are you sitting far away enough from it for comfort?
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Every organisation has an image it wishes to present to the public. A document 
can provide an opportunity for an organisation to promote itself. 6erefore it 
is essential that the choice of document, as well as its presentation and content, 
represents the organisation in the best possible way.

When designing and producing text documents it is important to ensure they 
reMect your organisation’s corporate image and style. You will need to develop the 
ability to clarify the task requirements so you can produce the most appropriate 
document. Knowing where to locate information about document design and 
structure and how to apply the information is a fundamental skill you will need 
every day in your job.

Communication with work colleagues is essential. When tasks are shared and if 
you are contributing to a common outcome, the way you communicate with your 
colleagues and interpret their instructions is critical. When given information 
to create a document, there may be several points you have to determine before 
proceeding.

Points to determine before proceeding when creating a document:

• Is this information for internal or external distribution?

• Is a letter, memo or fax the best way to distribute this information?

• What is the most eCcient way of distributing this information?

• What document format would present the required message to the best 
advantage?

Identify a document’s purpose

You will be asked to create several diEerent business documents when you work 
in an oCce. 6e style and type of document will be dictated by its purpose. 6e 
purpose could be to convey:

• new products

• public holiday arrangements

• sales or special events

• notices to other organisations

• new policies

• =nancial information

• your organisation’s annual activity

• new legislation.

1B Identify and clarify the purpose, 
audience and presentation 
requirements of a document



20
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

Identify a document’s audience

A document’s purpose and presentation is inMuenced by its target audience. 6e 
formality and style of the document will be dictated by your intended reader. An 
internal document may be less formal than an external document. For example, an 
internal document may be an invitation to a staE end-of-year party and would not 
be as formal as a dinner invitation for the board of directors. 

Discussion about the document’s purpose, appearance, target audience, other 
users and organisational standards is important as it oEers the document designer 
a vision of what is required.

Audiences may be:

• clients

• customers

• suppliers

• colleagues

• staE

• business associates

• industry organisations.

Identify the presentation requirements for a 
document

Once the document’s purpose has been established, and the audience de=ned, you 
will then need to decide what type of document is required and how it should be 
presented.

Some typical text documents are listed below.

Typical text documents

 • Simple or multi-page letters

 • Memos

 • Faxes

 • Promotional material including brochures, calendars, �yers and forms

 • Mail merge documents such as labels, reports, schedules and tables
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Letters

Letters are a communication tool used to pass on a wide range of business 
information. 6ey provide evidence or a record of a business activity. 6ey are also 
a personal point of contact between an organisation and its clients. A well-written 
letter will give a professional impression.

Some common types of letters are provided below.

Acknowledgments

 └ For example, to con�rm that your organisation has received 

something, or to acknowledge a job application.

Complaints and claims

 └ For example, to let a branch of your organisation know of a 

customer complaint, or to inform a supplier they have delivered 

faulty goods.

Adjustments

 └ For example, a reply to a customer who has complained to let 

them know their problem has been resolved.

Covering letters

 └ For example, to accompany what is being sent in a parcel of 

goods, or as an attachment to a document.

Follow-up letters

 └ For example, to con�rm something that has been agreed to 

verbally, or to con�rm a date or time for a meeting.

Inquiries

 └ For example, for information about who will be at a meeting, or to 

�nd out the availability of a conference centre.

Requests

 └ For example, for quotations for a service, or to ascertain prices.
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The structure of business letters

Most organisations use what is called a fully blocked layout. 6is has the entire 
letter (including the address) aligned on the le0 side and has single spacing 
between lines and a double space between paragraphs. Sometimes the punctuation 
is open, which means there is no punctuation outside the wording (body) of the 
letter itself. Some organisations use a mixed punctuation style, which means they 
place a comma a0er the greeting and the close.

Business letters will typically display the following elements.

Date

 └ The convention in Australia is to write the day, month and year; 

for example, 12 May 2015.

Sender’s address

 └ This is not necessary if your organisation has letterhead paper.

Name, title and address of the recipient

 └ If you do not know the person’s title, you should try to �nd out. If 

you are unsure how a woman prefers to be addressed, use Ms.

Greeting

 └ Sometimes called the salutation. This is usually ‘Dear’ followed by 

the same title and surname as used in the inside address. If you 

do not know the recipient’s name, you can use ‘Dear Sir/Madam’.

Body

 └ This is the main content of the letter.

Closing

 └ In a business letter the formal closing is ‘Yours sincerely’ if 

you know the name of the person you are writing to, or ‘Yours 

faithfully’ if you do not.

Signature and identi�cation

 └ This is usually six lines below the close. After the signature is the 

sender’s name and position in the organisation (the position is 

usually in bold).
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Example: business letter

J C J A C K S O N P H O T O G R A P H Y

“Capturing moments for eternity”

Shop 21, Fairholme Plaza
MAROOCHYDORE QLD R558
Ph: 07 5443 4237 
Fax: 075443 4238
Email: inquiries@jcjackson.net.au

Web: www.jcjackson.net.au

20 May 2016

Mr Donald Turner

Queensland Business Awards

21 Stephens Street

Cherrnside QLD 4032

Dear Mr Turner,

Thank you for the opportunity to submit the quotation for the provision of 
photographic services for the Queensland Business Awards.

The quotation includes a breakdown of prices for services as discussed at 
our meeting last week. Separate charges are included for the following:

 • Hourly charge for photographer

 • Proofs

 • Individual reprints

 • Bulk reprints

 • Enlargements

If you require any additional information please do not hesitate to contact 
me. I look forward to speaking with you soon.

Your sincerely,

Joshua Jackson 
Joshua Jackson

Manager

Organisation’s 

letterhead

Date

Recipient’s name 

and address

Greeting

Body (content)

Closing
Signature

Memos

A memo is an internal document that 
is sent to staE within an organisation. 
Memos can be sent to either one 
person or several people. Memos 
should have the same headings as the 
next example: Memo, Date, To, From 
and Subject.
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Example: memo

J C J A C K S O N P H O T O G R A P H Y

“Capturing moments for eternity”

Memo
Date:  12 May 2016

To:  All staA

From:  Joshua Jackson

Subject:  Film supplies

Due to the recent problems we have experienced with the 
use of Professional Image X100 high-speed Dlm we have 
negotiated with our supplier to return all remaining stock 
and receive a refund. Please return any Professional Image 
Dlm you have to Susie as soon as possible.

From now on all photographers must use Photo Gems 
XSpeed Dlm. We have received our Drst shipment of this 
Dlm and you can collect rolls from Susie.

Should you experience any diEculties with this Dlm please 
report to me immediately.

Regards,

Joshua Jackson 

Memo header

Date

Recipients

Sender’s name

What the memo is 

about

Body (content)

Signature

Faxes

A facsimile, or fax, is an electronically transmitted copy of a document. Sending 
a fax is a way to immediately send a hard-copy document from one location to 
another.

6e =rst page of a fax is usually a cover 
sheet that has details of the sender, 
recipient, recipient’s fax number, 
subject, date and number of pages. 6is 
cover sheet is then followed by any 
additional pages.
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Example: fax

J C J A C K S O N P H O T O G R A P H Y

“Capturing moments for eternity”

Shop 21, Fairholme Plaza
MAROOCHYDORE QLD R558
Ph: 07 5443 4237 
Fax: 075443 4238
Email: inquiries@jcjackson.net.au

Web: www.jcjackson.net.au

To:  Weber Auto Repairs

Attention:  James Patrick

Fax number:  01 3847 2900

From:  Joshua Jackson

Date:  18 October 2016

Re:  StaA photographs

No. of pages: 1  (including this one)

Hi James,

I really enjoyed doing the shoot with your staA and am glad to 
hear you are happy with the proofs. We have just started a new 
promotion and I wanted to let you know about it before you place 
your order.

November/December 2016 Special

During the months of November and December, corporate 
customers placing orders valued at $1000 or more will 
receive 50 calendars featuring the workplace image of 
their choice for no extra charge. These calendars make the 
perfect gift for your valued customers. Hurry! OAer ends 31 
December.

Things are certainly getting hectic here and I would suggest you 
place your order by the end of November to guarantee delivery 
before Christmas.

Please give me a call if I can be of any further assistance.

Regards,

Joshua Jackson
Joshua Jackson

Manager

Please check that you have received all pages. 
If not, please phone 07 5443 4237.

Organisation’s letterhead

Recipient’s company name

Recipient’s name

Recipient’s fax number

Sender’s name

Date

Subject

Number of pages being sent

Greeting

Body (content)

Closing

Signature

Sender’s identi�cation

Footer
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Promotional materials

Promotional materials are used to promote an organisation and its products and 
services. 6ese include Myers, brochures, invitations, business cards and price lists.

Information that may be printed on promotional materials includes:

• an organisation’s name

• logo

• telephone and fax number

• street or postal address

• email address

• web address.

Flyers

A Myer is a piece of paper distributed to a wide audience to advertise an event, 
product or service. An organisation may produce a Myer to post to clients to inform 
them of a special oEer, or to let staE know about an upcoming event. 6e purpose 
of a Myer is to attract people’s attention and interest them in the Myer’s subject.
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Example: <yer
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Brochures

A brochure is a piece of promotional material distributed by an organisation to 
provide information about its products and services. Brochures also oEer other in-
depth information about a speci=c product or range of products. Brochures can be 
either single or multiple pages and are o0en printed in colour with a glossy =nish. 

Example: tri‑fold brochure

continued …
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… continued

Example: tri‑fold brochure

Did you notice that the �rst page looks like it is backwards? When you create tri-fold 

brochures you need to create it this way so that when it is printed double-sided the content is 

displayed correctly. If you open a brochure template in Word, you will see this is how it is laid 

out.

Forms and tables

Forms are used by organisations to record and 
collect information. Forms can be single or 
multiple pages and can be created to meet any 
need. Common forms include customer feedback 
forms, order forms and time sheets. Your word-
processing so0ware has a range of features you 
can use to create forms, but one of the more 
popular methods is to use either one or a series 
of tables.
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Example: customer order form 

Review the Plants By Post order form. Four tables were used to create this form. Try to work 

out where they all are.
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Form creation tips

Have you ever tried to =ll in a form where the lines were too close together and the 
spaces provided were insuCcient for the required responses? 6is is something you 
must be aware of when creating tables to ful=l that function.

Tables allow information to be displayed or collected in a clearly de=ned space. 
When using tables to display data, the use of headings for the rows or columns 
makes it easy for the reader to understand the data.

6e table below demonstrates how eEective tables are for presenting and 
clarifying data. 

Number of new vehicle registrations

Year Victoria New South Wales

2009 42,567 31,789

2010 44,214 32,854

2011 41,289 38,956

Imagine if the information were presented in sentence form. 6is is exactly the 
same information:

Victoria had 42,567 new vehicle registrations in 2009, 44,214 in 2010 and 41,289 
in 2011 while New South Wales had 31,789 in 2009, 32,854 in 2010 and 38,956 
in 2011.

Reports

A report is a document that outlines 
information about an activity in an 
organisation. A report may be written 
about the progress of an existing 
project, to detail the feasibility of a 
future project or to summarise the 
=ndings of research that has been 
undertaken. Writing a report is a way 
of communicating organisational 
information to a wide audience.

Reports o0en include a lot of details that need to be collected from multiple people 
within or outside an organisation. For example, multiple teams may be working on 
one project and their progress needs to be recorded in one report.
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Formal reports

A variety of formal reports are produced by large organisations. 6ese include 
annual reports, =nancial reports, feasibility reports and project reports. 6ese 
formal reports can be hundreds of pages in length and o0en use complex 
numbering systems so that people reading the report can easily locate information. 

6e structure of formal reports usually includes the following elements:

• Title page • Table of contents

• Lists of tables or graphs if 
necessary

• Summary of key points (executive 
summary)

• Introduction • Main text (containing data, =ndings etc.)

• Conclusion • List of recommendations

• References and 
acknowledgements

• Appendices

Short reports

Short reports are less formal in structure and usually one to three pages in length. 
6e structure will be customised to suit the data being presented and the audience. 
Examples of short reports include the results of a review of customer service 
standards, recommendations for a change of stationery supplier or purchase of an 
item, or a progress report on arrangements for a function you are organising. 6e 
structure of a short report is usually as follows:

• Introduction

• Main text (containing data, options, =ndings)

• Recommendations and conclusion

Due to the short length of these reports there is usually no cover page or table of 
contents; instead, headings provide structure.
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Example: report

The following is an example of a one-page report recommending the purchase of a new 

printer.

Schedules

A schedule is a list or plan that shows the order in which a number of events will 
take place. Schedules can also be used to list tasks that need to be completed. 
Commonly used schedules include itineraries, appointment diaries and timetables.
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Example: itinerary

The following example is an itinerary for internal staff distribution.
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Calendars

Calendars are used to give an overview of events, appointments or meetings over a 
period of time. Calendars can also be used by organisations for booking resources, 
such as a meeting room, or for recording information, such as when staE will be 
on annual leave.

Example: calendar

Following is an example of a calendar showing workshop dates. This calendar is to be 

distributed to the company’s external clients; therefore, the company logo, phone number, 

email address and web address must be displayed.

Training Calendar June 2016

Sun Mon Tue Wed Thur Fri Sat

1 2 3
Intro Internet/

Email 

Workshop 

9am–12pm

4

5 6
Training 

Centre Open 

Day 

 9am–12pm

7 8
Microsoft 

Word 

Workshop 

9am–4pm

9 10 11

12 13 14 15 16 17
Adv Internet/

Email 

Workshop 

9am–12pm

18

19 20 21 22 23
Web Page 

Design 

Workshop 

(Day1) 

9am–4pm

24
Web Page 

Design 

Workshop 

(Day2) 

9am–4pm

25

26 27 28 29 30

For more information contact Techno Train

Phone: 07 3867 1333 Email: info@technotrain.com.au Web: technotrain.com.au
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Mail merge

One of the most useful word-processing skills you can learn is how to create and 
perform a mail merge.

A mail merge is performed by combining the contents of two documents or =les 
– one that contains the information you are sending and one that contains the 
details of the recipients (data source). 6e two =les can be in the same program or 
in diEerent ones. For example, the data source may be in Microso0 Excel and the 
mail merge may be done using Word.

Mail merges can be used to customise documents including letters, labels, 
envelopes, faxes, Myers and statements. 6ey are especially useful when sending a 
mail-out to many recipients.

Below is a sample of some labels generated using the mail merge wizard in Word.

Alex Barney & Co

21 Ergett Street

IPSWICH QLD 4305

We Care Pharmacy

PO Box 38

CHERMSIDE QLD 4032

Ableton Accountants

PO Box 23

CHERMSIDE QLD 4032

Daleys Fresh Fruit

98 Berwick Street

DECEPTION BAY QLD 4508

Clarify a document’s requirements

Every organisation has diEerent requirements with varying levels of formal 
documentation. As part of an induction to a workplace you may be shown where 
to access the style guide or policies and procedures manual. If you weren’t shown 
or you have forgotten, ask your supervisor where these documents are and how to 
access document templates on the computer.

If your organisation does not have a formal style guide, you could locate examples 
of documents that have previously been created and follow them. For example, 
locate last year’s annual report. Identify whether the layout is still appropriate, and 
then use it as a guide. Show your supervisor the document you are planning to 
follow so you know you have the right type of document and style. You may wish 
to ask your supervisor if they would like you to create a style guide and templates 
for everyone to use.
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Practice task 2 

1. Explain the purpose, audience and presentation of the required document in the following 

situations. 

 • The advertising department requires a new price list.

 • The payroll department wishes to have new PAYG information distributed.

 • The purchasing department wishes to advise that a product is no longer available.

 • The WHS committee is having a meeting and asks for agenda items.

 • The company is moving to new premises.

Enter the information into this table.

Purpose Audience Presentation

continued …
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… continued

Practice task 2 

2. Why would it be inappropriate for a person’s travel schedule to be circulated outside of an 

organisation?
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Producing text documents that meet an organisation’s requirements takes more 
than just great computer skills. Every time you produce a document you should 
apply your knowledge of organisational policies and requirements to ensure your 
work conforms to the established style and company image.

Why organisational requirements are important

Production guidelines are implemented for several reasons. One of the most 
important is to ensure that documents have a consistent style and image. By 
following organisational guidelines, all staE will create documents that have a 
similar style and format. 6is means that customers, business associates and 
anyone receiving material from your organisation will instantly recognise it as 
belonging to your organisation.

In many cases written 
communication forms most of an 
organisation’s contact with its clients. 
Each time a client has contact with an 
organisation, they form an opinion 
based on the documents they receive. 
In some instances an unprofessional 
looking document, or one containing 
errors, can be the diEerence between 
gaining and losing a client.

Conforming to organisational requirements will also ensure you are able to 
complete your work in an eCcient and timely manner. It is very frustrating to have 
spent hours working on the design of a document, only to =nd it does not meet 
requirements. To avoid a situation like this, there may be a simple template you 
could use.

1C Identify requirements to ensure 
consistency of style and image
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Common organisational requirements

Every organisation has diEerent requirements for business documents. Most 
important is to present an appropriate and consistent corporate image by using the 
organisation’s logo, colour scheme and house styles or an in-house style guide.

Most organisations outline document production procedures and guidelines 
either in their policies and procedures manual or in a speci=c in-house style guide. 
Make sure you know where these instructions are kept and that you are familiar 
with them.

6e requirements appropriate for one organisation may not suit another; for 
example, a law =rm’s requirements would be diEerent from that of a sports 
equipment retailer. 

To prepare appropriate documents for your organisation you must follow 
established guidelines and procedures for production.

Established guidelines and production procedures may include:

• Adhere to content restrictions.

• Use templates.

• Include the organisation’s name, time, date, document title, =le name etc. In 
the header and footer.

• Observe copyright legislation.

Present a consistent corporate image

6e easiest way to understand the concept of a 
corporate image is to think of it as a uniform 
for your text documents. Many documents can 
wear this uniform, including correspondence, 
forms, emails, faxes, memos, websites, invoices, 
statements and reports. Just like staE in a company, 
this uniform may vary; for example, managers 
o0en wear a diEerent company shirt or uniform 
to the other employees. Documents can also 
incorporate diEerent parts of the company’s image 
into their design.

A corporate image has several components, including:

• logo

• colour scheme

• house styles and templates.

Consistent use of the same colours, logos and designs ensures that documents are 
easily recognised as belonging to your organisation.
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Follow guidelines and procedures

Many organisations have policies and 
procedures for staE to follow, including 
style guides and templates for producing 
documents. 6e structure and content 
of these style guides and templates are 
determined by the organisation. In larger 
organisations and government departments 
they are usually clearly de=ned, while 
smaller organisations o0en have no formal 
documented style guide and staE are 
expected to follow examples of documents 
previously produced.

Style guides

Style guides vary between organisations: some may be available in hard copy 
and others on the intranet. Make sure you know where to =nd a copy of your 
organisation’s style guide. Style guides o0en provide information on the desired 
writing style and might also specify the preferred formatting of text and pages. 

Below are some styles relevant to writing and text and page formatting.

Writing style

Writing style information:

 • The use of abbreviations

 • Preferred spelling of words; for example, Australian not 

American English

 • Use of hyphens

 • Use of capitals

 • Use of full stops

Text and page formatting

Text and page formatting information:

 • Fonts, font sizes and colours

 • Margins

 • Indenting 

 • Bullets and numbering

 • Headers and footers

 • Borders
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Example: style guide information

The following is an example of some things that might be included in a style guide.

Dates

Our date style is day month year; for example, 30 June 2014.

Legislation

When referring to an Act of parliament, if the date follows the Act, the Act must be written in 

italics. If there is no date, italics are not necessary; for example:

Copyright Act 1968 (Cth)

the Privacy Act

Spelling and hyphenation

C

checklist

check-up

Commonwealth

coordinate

cost-ef�cient

Preferred layouts

6e organisation’s preferred layout and formatting of documents can also be 
applied by using templates for letters, faxes, memos, reports, invoices etc.

A style guide might describe the process for:

• naming and storage of =les

• the use of disclaimers (disclaimers are notices placed on correspondence and 
documents by organisations to remove them from risk of legal liability where 
people either misinterpret or misuse information, or repeat information they 
should not have received).
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Example: email disclaimer

Most organisations use disclaimers at the bottom of all emails they send. This may look 

similar to the following:

This email is intended for the use of the addressee only and may contain con�dential 

information. If you are not the intended recipient, you are hereby noti�ed that any use or 

dissemination of this communication is strictly prohibited. The sender disclaims liability 

for any errors, omissions, viruses, loss and/or damages arising from using, opening or 

transmitting this email. If you received this transmission in error, please notify JC Jackson 

Photography immediately on (07) 5443 4237, then delete this email.

Templates

Templates are established style models used to create documents. Most 
organisations store electronic templates that are pre-formatted for use in 
producing documents. Templates de=ne for the user the preferred layout and 
text formatting for documents, increasing eCciency in production and ensuring 
consistency in design. Printed copies of templates will o0en be included in the 
style guide.

Word includes a range of templates for documents, including letters and faxes, 
memos, reports and calendars. 6e advantages of templates are shown below.

Consistency

Using templates ensures that information presented to clients is 

always presented in the same manner, making it easier for them to 

locate important information. An example of a common template is 

the layout of a monthly bank statement. Because the information 

is always presented in the same format, the reader knows where 

to �nd the various transaction details.



44
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

Saved formatting

Templates can be as simple or complex as required, and saved 

formatting can include margins, fonts, columns, headers and 

footers, logos, colours and styles.

Template integrity

Because templates are used by various staff members, 

organisations must ensure that no changes are accidentally 

made to them. For this reason templates should be saved in a 

speci�c location as a special template �le type. So when you use 

a template you actually open a new document based on that 

template, which ensures the original remains unchanged.

Headers and footers

Many organisations use the headers and footers as an easily identi=able location to 
place important information. Depending on the document type, headers or footers 
may be used to display information such as:

• the name of the organisation

• the document title

• the =lename and path

• the location, date and time the document was created.

6e contents of headers and footers can be saved for use on templates.

Take a look at the headers and footers and page numbers in a phone book. Notice 
the way they are constructed to give the reader information.

Content restrictions

6ere are some details you are not 
permitted to give out in written 
documents. 6e kind of information 
subject to content restrictions 
depends on the organisation and 
may include results of investigations, 
=nancial data or employee data.

Content restrictions can also be 
applied to the way an organisation 
words its documents.
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Organisations are o0en very careful about the way they phrase information to 
ensure it is not misinterpreted or acted upon without professional advice being 
sought. For example, a =nancial planning =rm that recommends a particular share 
purchase in its monthly bulletin may include a line that says: ‘Please consult your 
=nancial adviser before acting on any of the information received in this bulletin’.

When creating documents, check with your supervisor to ensure you are following 
your organisation’s guidelines regarding restricted content.

Copyright legislation

Copyright ensures that individuals and organisations do not copy or reproduce 
content, including text or images, from another source without receiving 
permission or acknowledging the original author. 6e Copyright Act 1968 (Cth) is 
the legislation governing copyright in Australia. 6e Act has been amended since 
1968 to ensure it meets changing copyright needs.

To ensure you avoid breaching copyright laws, always 
record the details (for example, who wrote it, where you 
found it) of any images or passages of text you are 
borrowing from another source and reference them 
appropriately. Although information about appropriate 
referencing methods can generally be found in an 
organisation’s style guide, check with your supervisor to 
ensure you are doing it correctly because breaching 
copyright can lead to your organisation being sued.

For more information on copyright, visit the Australian Copyright Council’s 
website at: www.copyright.org.au.

Determine task requirements

It is important to accurately determine the tasks you need to perform when 
preparing a document. 6e more organised and eCcient you are, the easier it will 
be to produce a well-designed document that conforms to your organisation’s 
requirements and meets audience expectations.

6ere are many tasks you may be required to complete when producing letters, 
memos, faxes, promotional materials, forms, tables, reports, schedules, calendars 
and mail merge documents.

You need to identify whether you are required to follow an existing template or 
design the document yourself. 

Using your knowledge of document design and corporate image, you may need to 
identify whether:

• you are required to include the company logo and, if so, where

• there is a standard font to use
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• you are using the recommended language style; for example, not too much 
jargon and a suitable tone, such as friendly or formal

• there are budget constraints; for example, you might design a great two-page 
brochure, but the budget may only be for one page

• you are allowed to include any design features you wish

• the copyright symbol must be included.

Letters

You need to check whether attachments or enclosures 
are necessary, such as references, cheques or brochures. 
You type encl. and the number of enclosures under the 
sender’s identi=cation. If you are sending the letter to 
more than one person, you should write cc (originally 
meaning carbon copy) underneath and include the 
names of all the recipients.

Many organisations also require a reference line at the 
bottom of the letter that refers to the organisation’s electronic =le or paper records, 
or the person who has prepared the document.

For letters that use more than one page, check your organisation’s style guide 
regarding the type of paper to use. Some organisations use letterhead paper 
only for the =rst page and print subsequent pages on corporate coloured (blank 
paper the same colour as the letterhead) or white paper. Other organisations use 
letterheads for all pages.

6e page number and sometimes the number of pages are usually shown in the 
footer on each page. For example, 1/3 (meaning page one of three) may be shown 
on the =rst page of a three-page letter but more likely a 2/3 and 3/3 on the second 
and third pages with no numbering on the =rst page.

Memos and faxes

Organisations normally have a standard layout for memos, which is saved as a 
template. If your company does not have a template, use a standard memo layout 
from Word.

To =nd out the procedure for sending faxes in your organisation, refer to the style 
guide or policies and procedures manual. If your organisation does not have a 
template, follow the standard layout available in Word.

Promotional materials

Creating Myers and brochures requires you to use your design skills. Before you 
can produce the Myer or brochure, you need to know if it will be in colour or black 
and white, the paper size it will be printed on and what information must be 
included. Information that will usually be printed on a Myer or brochure includes 
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the company name, logo and telephone number, although other details may also 
need to be included. Check your organisation’s style guide and templates and 
always ask another person to review your design and =nished Myer or brochure. 
Below is some useful information for producing a range of promotional materials.

Forms and tables

Just like �yers and brochures, designing new forms will require 

you to use your design skills. You will need to know if they will be 

in colour or black and white, the paper size they will be printed 

on and what information must be included. The information to be 

included may depend on whether the form is for internal company 

use or external (client) use. Check your organisation’s style guide 

and templates and always ask your supervisor to review your 

design and �nished form.

Reports

You need to undertake a variety of tasks when preparing a report. 

You need to determine the complexity of the report, including its 

length, structure and the level of detail needed to suit the purpose 

and audience. See your organisation’s style guide or templates for 

the preferred layout.

Schedules

As schedules may be distributed either within an organisation or 

to external clients, make sure you follow the guidelines in your 

organisation’s style guide and templates and get your supervisor’s 

approval for the �nal document and distribution.

Calendars

Calendars are usually generated for the month, but can be 

customised to any length.

The easiest way to create a calendar is by using the inbuilt 

wizards in your word-processing or desktop publishing software. 

The major advantage of using these wizards is that the dates 

are automatically generated. Like schedules, calendars can be 

distributed to internal or external clients. 

To ensure you uphold the required corporate image, follow the 

guidelines in your organisation’s style guide and templates and get 

your supervisor’s approval for the �nal document.
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Mail merge documents

You should treat mail merge labels like any other document, 

applying styles and formatting according to your organisation’s 

guidelines.

Practice task 3 

Imagine you work for JC Jackson Photography. You have been asked to create a �yer 

advertising a special offer on reprints, which includes a free gift.

1. List at least three things that must be included in the document.

2. Write a list of at least �ve questions you would ask your supervisor in order to clarify the 

task requirements.
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Summary

1. Ergonomics is about creating comfortable working conditions and setting up 
a workstation to suit your physical requirements, which can prevent undue 
stresses and strains. Performing exercises during the working day can stop the 
causes of pain and discomfort.

2. Use equipment to improve your posture and be aware of environmental 
factors in the workplace – such as lighting, noise and air quality – that aEect 
people’s health.

3. Plan daily tasks to prevent repetitive work being done for long periods of 
time. Take short breaks at regular intervals to combat stress and prevent pain 
and discomfort. Enjoy rest periods to relax and think about something other 
than work.

4. Conserving resources at work bene=ts the organisation by reducing costs and 
bene=ts the planet by reducing greenhouse gases and the amount of material 
sent to land=ll.

5. Organisational requirements are important because they ensure all documents 
produced are consistent in style and layout and include:

• presenting a consistent corporate image

• following style guides and templates

• adhering to content restrictions

• observing copyright legislation.

6. Documents produced by an organisation include letters, faxes, memos, 
promotional materials, reports, forms, calendars, schedules and mail merge 
documents.

7. You should always clarify the task requirements before producing your 
document to ensure you create the right document type and use the 
appropriate style and design elements.
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6is learning checkpoint allows you to review your skills and knowledge in 
preparing to produce word-processed documents.

Part A

1. ‘6e environmental factors of a building can contribute to the productivity of 
an organisation.’ Write one A4 page describing how noise, light and air quality 
could aEect productivity at work.

Learning checkpoint 1 
Prepare to produce word‑processed documents
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2. 6ere are two ways of conserving resources in an oCce environment: 
minimising paper wastage and minimising energy use. Using a table similar to 
the following, list as many conservation techniques as you can think of; that is, 
not just the ideas mentioned in this topic.

Minimising paper wastage Minimising energy use
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Part B

Read the case study, then complete the tasks that follow.

Case study

Angelina works as an administration of�cer. Her main tasks are reception duties, word 

processing, handling the mail and �ling. Most days Angelina’s manager gives her urgent 

work in the afternoon that needs to be completed that day. Her time lines are always very 

tight and she often �nds that she has to work during her lunch hour and for an extra half 

hour in the evening. She is always exhausted and is becoming stressed.

To make matters worse, Angelina �nds that work is often just dropped on her desk, which 

makes her desk disorganised and dif�cult to use. She can’t alter her chair and there is 

glare coming from her screen. She often leaves work with a headache and a backache.

1. List all the unsafe work practices Angelina experiences.

2. For each of the unsafe practices you have listed, describe a solution.
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3. In half an A4 page, describe why work organisation and ergonomics lead to 
better employee health.

Part C

1. For each of the following tasks, list the type of document that needs to be 
produced (for example, fax, memo) and why it is the best choice. You do not 
have to produce the documents.

• Con=rming an appointment time

• Distributing information to a large number of people regarding a product 
that is on special

• Sending a personalised invitation to 50 valued customers to attend a 
product launch

• Providing a hard copy of information requested in a phone conversation 
to a staE member in another organisation. 6e information is needed 
immediately

• Advising staE in your organisation that a meeting is being held to discuss 
the new enterprise bargaining agreement that is being negotiated

• Collecting information from customers regarding the quality of customer 
service the organisation is providing

• Letting your supervisor know the results of your research into which 
catering company would do the best and most cost-eEective job of 
providing lunches for monthly staE meetings. Your supervisor also 
requested a brief overview of each company’s prices and a sample menu
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2. Based on what you have learnt in this topic, evaluate the consistency of an 
organisation’s corporate image.

a) Collect several documents from the same organisation (for example, letters, 
statements, invoices, brochures) and compare them. Banks and insurance 
companies are good organisations to use for this exercise.

b) What features do all the documents have in common?

c) List at least =ve things that contribute to presenting a consistent corporate 
image. Alternatively, if the organisation is not presenting a consistent 
corporate image, write half an A4 page of suggestions that could be 
implemented to enable it to do so. 
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3. Develop a checklist of 5–10 questions you can ask to help you clarify the task 
requirements for a document you have been asked to produce. 

• Word process the checklist. 

• Use one of the documents listed in this topic as an example.

• Submit the completed checklist to your trainer. You do not need to submit 
the word-processed =le.
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One of your main duties when working in an oCce may be creating and editing 
word-processed documents. To ensure you perform your duties in an eCcient 
manner, you must establish the purpose, audience and information requirements 
for documents before you start creating them. In this topic you will become 
familiar with the various information requirements and design elements that must 
be considered, along with the functions you can use to ensure consistency in your 
documents.

In this topic you will learn how to:

2A Design the structure and layout of a document

2B Design the document to enhance readability and appearance

2C Ensure consistency of design and layout
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Various factors inMuence the structure and layout of a document. You should 
consider the purpose of the document and the information that must be included, 
as well as who is going to be reading and using the document. You should 
ensure you have clari=ed each of these points before starting the design of your 
document.

What is the document’s purpose?

If you are asked to produce a word-processed document, the =rst thing you must 
clarify is the purpose of the document. Its purpose will determine the way it is 
planned and designed.

6e type of document you select and the layout you apply are also determined by 
its purpose; for example, if you are writing to con=rm a meeting time with a client 
you might choose a letter, but if you wish to advertise a sale you might choose 
a Myer.

A document’s purpose will also inMuence how 
formal the document is. If you are producing 
an invitation to a black-tie function, it will 
need to be formal and stylish to suit the 
occasion. In contrast, a Myer advertising an 
end-of-year staE party could use a more 
informal design.

Who is the audience?

When you are producing a word-processed document, you need to keep in mind 
who it is intended for when deciding how the information should be presented. 
6e audience helps you determine the writing style to use; for example, formal, 
informal, detailed or brief notes. A full report rather than a summary of the key 
points would be needed for a group of executives.

6e language style and amount of jargon used should be suitable for the audience. 
If you are developing a document for clients who are not familiar with the subject 
matter, you may need to avoid using jargon so they don’t become confused, or 
include a glossary that explains the technical terms you have used.

A document’s audience also inMuences its design, including the choice of fonts, 
graphics and layout of the information. For a formal report, you might use 
photographs, diagrams and tables that represent signi=cant data, whereas for a 
newsletter you might choose some Clip Art graphics.

2A Design the structure and 
layout of a document
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What information is required?

Most documents you create will have speci=c information that must be included 
in them. 6is may be information to maintain you organisation’s corporate image; 
for example, the company logo or standard headers and footers. It could also be 
information that is critical to conveying the document’s message; for example, a 
Myer about an upcoming workshop must include the date, time and venue of the 
workshop.

6e design of the document will be 
determined by the information it 
contains. You need to consider the 
type of information and the clearest 
way to display it. Is the information 
communicated in graphics or text? 
Would you use bullets, tables or 
columns? Once this is clari=ed, you 
can identify how you will structure 
and lay out the document.

Structure and layout

A0er you have determined the purpose, information and audience requirements 
for the document, you can implement the design. Designing a document refers 
to the way you organise the content and layout. You should take several design 
aspects into consideration.

Design aspects to consider:

• Boxes • Colour

• Columns • Graphics, photographs and drawings

• Headings • Letter and memo conventions

• Page layout • Typeface

• White space

Boxes

Text boxes can be used to give clearly de=ned borders or edges to particular 
content on a page. Putting an item in a box can make it stand out. Using design 
elements – such as boxes –consistently on a range of documents can help the 
audience to quickly locate information they have a particular interest in. An 
example of this is displaying small advertisements in a newsletter. If you use the 
same positioning and boxed design in each edition, readers will learn to look for 
the information in that format. 
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Example: <yer design

Following are two designs for a �yer. You can see how the boxes in the example on the right 

grab the reader’s attention.

Colour

6e use of colour in documents can be valuable both for presenting a consistent 
corporate image and for making items stand out. When one section of a 
document is in colour and the remainder is in black and white, the reader’s eye is 
automatically drawn to the coloured section.
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You may also need to consider the colour of the paper you will be printing your 
document on, as some fonts and graphics may not be easy to read on coloured 
paper; for example, black print can sometimes be hard to read on dark red or 
blue paper.

Look at newspapers and magazines to =nd examples of the eEective use of colour. 
Advertisers o0en pay extra for coloured advertisements to make them stand out.

Columns

Columns are a popular design element for forms and newsletters. In newsletters, 
columns can be used to create interest and to separate articles from each other. 
Altering the number of columns can give you more options when =tting in 
graphics and tables, allowing you to fully utilise the space.

Example: column design

Look at the version of the Capricorn State School newsletter shown on the right in the 

following example and you can see how the use of two columns in the top half of the page �ts 

in the three small articles and makes them easy to read. The single column at the bottom of 

the page is used to �t in the biggest of the articles.

By contrast, for the same newsletter in one-column layout, as shown on the left, the top 

article appears to have too much white space or gaps and the information in the second two 

articles is mixed with the tables. This is not a well-designed document.

When designing forms, the use of rows and columns can allow for the effective collection of 

data in the available space. Columns on forms guide the user to record information in the 

correct place. When designing forms, tables are often used to create the required columns.
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Graphics, photographs and drawings

Graphics, photographs and drawings can be powerful design tools. 6ey can be 
used to break the monotony of continuous text or to clarify information.

6e use of appropriate graphics can help the audience understand the document’s 
contents. An eEective use of graphics could be using an eye-catching picture to 
draw the audience’s attention to a Myer, or using the company logo on documents 
to portray a consistent and professional image to corporate clients.

Example: graphic design

Graphics such as tables and graphs can also be used to represent data, as shown in the 

following example of a sales report. Using this technique is very effective when presenting 

data to a corporate audience.
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Headings

Headings are a valuable way to give 
a document structure. 6ey help the 
reader to pick out the main topics and 
discussion points or quickly skim the 
document to get an idea of what they 
are about to read. Ensure that headings 
are relevant and concise, and use a 
consistent font and style throughout the 
document.

Headings are important when creating long reports and documents because of the 
amount of text and information the reader needs to absorb. Take, for example, the 
headings in this book, which tell you what you are about to learn and allow you to 
=nd the information quickly. Eye-catching and descriptive headings on Myers and 
promotional materials help attract the audience’s attention.

Letter and memo conventions

When designing letters and memos it is important to use any available templates 
and follow the guidelines in your organisation’s style guide. As explained in 
Topic 1, a template is an established style model for a document. Using templates 
helps ensure that all required information is included and that you maintain the 
organisation’s consistent corporate image.

Make sure you are familiar with the letter and memo templates used in your 
organisation and follow the conventions set out in the style guide.

Page layout

Page layout refers to the way all the diEerent elements on the page come together. 
It is the integration of all the great design ideas we have and making them work 
together. First, you must ascertain what size your document will be – it could be 
A4, A5, letter, B5 or a custom size – and how many pages the document will have. 
If the document is being mass-produced (for example, Myers and newsletters), the 
paper size and number of pages will usually be determined by the printing budget, 
so make sure you are clear on your organisation’s requirements before creating the 
document.

You must make eEective use of the space available. Setting appropriate margins 
for your document will ensure you have the optimum amount of space to work 
with. When deciding on the layout of a page, you need to assess the importance of 
each piece of information and make sure the reader’s eye is drawn to what is most 
relevant. Your organisation’s style guide will outline any elements of documents 
that must be included and you will o0en =nd these items have standard positions 
on the page so as to maintain the corporate image. It is good to position these =rst 
and then consider the layout of the remaining information.
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Example: page layout

The following is an example of two versions of a customer satisfaction survey. Both 

documents include all the necessary information but only the one on the right has an 

effective page set-up. The result is a document that is easy to �ll in, which means that 

customers are more likely to take the time to complete the survey.

Improvements we can see in the document on the right compared with the one on the left:

 • A border has been added

 • Use of a large, clear heading

 • Plenty of space is allowed for written answers

 • Question numbers added, which will make collation of data easier

 • Effective use of the whole page (no gap left at bottom)

Typeface

Most word-processing so0ware packages give us at least 50 choices of typeface 
– commonly referred to as fonts. Some of the better known ones are Times New 
Roman, Arial, Comic Sans MS and Courier. Some fonts can be hard to read and 
you need to consider this when designing your document. It can also be confusing 
for the reader if you use a lot of diEerent fonts that don’t go well together.  

Your selection of font will also be inMuenced by the audience and purpose of 
the document you’re producing. A report with a large amount of text needs 
to be presented using easy-to-read fonts, such as Times New Roman or Arial. 
Alternatively, a more casual font, such as Comic Sans MS, may be suitable for an 
informal invitation, as it appears warm and welcoming.
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Example: typeface

In the two examples of reports shown below, you can see how the one on the left is far easier 

to read because it uses consistent fonts for the headings and body text. The Arial font that 

was selected is easy to read and suitable for a large document. The report on the right has 

too many different fonts, some of which are hard to read; the reader may not even be sure if 

all the sections are related.

White space

White space refers to the blank space or gaps around parts of the document. 
Leaving appropriate amounts of white space around these elements ensures the 
document does not become too crowded and confusing or that items don’t look 
too isolated and out of place.

It is not essential to =ll up every bit of space on the page, but you don’t want to 
leave a big empty blank area either. Sometimes leaving some space around an item 
can draw attention to it.
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Example: white space

Look at the two documents in the following example. The one on the left has an even amount 

of space at the top and bottom and on each side of the centred information. This use of white 

space draws attention to the details of the laptop and to the contact details for Huxley and 

Associates.

The document on the right uses the space poorly; all the information is squeezed into the top 

part of the document and a large gap is left at the bottom. The reader’s eye is not drawn to 

the details of the laptop as this blends in with the rest of the text.
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Practice task 4 

Read the case study, then answer the questions that follow.

Case study

Jennifer works as an of�ce assistant for a training organisation. Her supervisor assigns 

her the task of creating a monthly newsletter. She presumes the newsletter is going 

to be distributed to the organisation’s clients. She spends several days working on the 

newsletter, researching various hints and tips, creating a training calendar and preparing 

trainer pro�les.

She presents her draft newsletter to her supervisor and learns that she was actually 

meant to create an informal staff newsletter for the organisation’s employees. Most of 

the work she has done was unnecessary.

1. What might the consequences of Jennifer’s actions be?

2. How will her workload be affected?

3. What can Jennifer do to avoid this problem in the future?

continued …
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… continued

Practice task 4 

4. Collect three documents (for example, letters, faxes, reports, �yers) and write a description 

of how white space is used in each. The documents can come from any source: it may be 

something you have received in the mail, that you or other employees have created, or that 

you have found on the internet. Ensure at least one of the documents is an example of 

poor use of white space. Include details of what you would do to �x the problem.

5. Consider an internal memo and a promotional brochure. How would the purpose of each 

document affect its design and layout?



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

69

Topic 2
Design word-processed documents

Have you ever looked at a document and thought how fantastic it looks or how 
easy its message is to understand? Or have you ever been le0 confused by a 
document, wondering why more thought wasn’t put into the design and exactly 
what message it is trying to relay? Documents are important communication tools 
that need to be suitable for the audience and purpose, as well as being visually 
appealing and easy to read.

When producing word-processed 
documents it is vital that you 
spend time working on a design 
that is readable, eye-catching and 
meets task and organisational 
requirements. Remember that 
everyone has a diEerent opinion 
and what you think looks great may 
not appeal to someone else, so don’t 
forget to ask for feedback.

Design elements

6e following design elements are basic guidelines you should follow to ensure the 
readability of your =nished document. 

Consider the following as part of the design process:

• Balance

• Diversity

• Relative positioning of graphics and headings

• Simplicity

• Text Mow

• Typography

Balance

Balance refers to the way text and graphics are distributed on the page. A 
document is unbalanced if all the content is at the top or bottom, or le0 or right 
of a page with very little on the opposite side. 6ere should also be a balance 
between the amount of text and graphics on a page so that the page doesn’t look 
overcrowded or dominated by one feature. Distributing the text and graphics 
throughout the document will also contribute to achieving balance.

6e two versions of ‘Laptops for Sale’ earlier in this topic show a well-balanced and 
a poorly balanced document.

2B Design the document to enhance 
readability and appearance
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Diversity

Word-processing so0ware packages oEer many diEerent ways to present and 
format your documents. Although you need to maintain your organisation’s 
corporate image, it is still important to keep documents such as Myers, brochures 
and newsletters interesting. 6is can be achieved through careful use of the diverse 
range of formatting options available.

You can vary how you arrange documents such as a monthly newsletter or report. 
Where similar data is produced each month, you may choose to change the way it 
is displayed. One month you may use a table to display sales =gures, and the next 
month you may use a chart. 6is allows you to maintain the overall look and feel 
but still keep it interesting.

Relative positioning of graphics and headings

When placing headings, body text and graphics on a page you need to ensure 
that they are positioned so the information is easy to understand. 6e position 
of headings and graphics can really help or hinder the reader in understanding a 
document.

As a general rule, in documents such as reports and newsletters, a graphic should 
not be directly under a heading as this area is reserved for the text that explains 
what the section is about – the introduction. Graphics should be placed close to 
the text they relate to.

Example: use of headings and layout

Following are two examples of how headings and graphics are used in a report. The report 

on the left has the graphic following directly after the heading. The problem with this is 

that the heading seems lost and no longer related to the text. The document also appears 

very unbalanced. The document on the right is a good example of positioning headings and 

graphics and you can see how much more balanced it appears. 

You should note that this rule does not apply to documents such as �yers because of the 

limited amount of text they normally contain.
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Simplicity

One way to make text more readable is to use a simple design that is not crowded, 
disjointed or too busy. 6e text should be large enough to read and should Mow in 
a logical manner. Try not to change between single and multiple columns more 
than once on each page, use borders 
and boxes sparingly, and stick to one 
colour scheme. Remember you don’t 
have to use every single feature oEered 
by your so0ware.

Have a look again at the laser printer 
purchase examples earlier in this topic 
to see how simple font choices can 
work best.

Text <ow

Text Mow refers to the way passages of text are positioned in a document. 6e 
way text Mows in a document is one of the most critical elements inMuencing its 
readability; if text Mow is arranged carelessly, the reader can become confused. 
Text can Mow from one column to another or from one page to another. 
Newsletters, newspapers and magazines regularly have to split articles across 
columns or pages in order to =t text in, so it is vital to ensure the reader can locate 
the follow-on text.

When text from a particular article has to Mow over more than one page, you 
may decide to include information that tells the reader where to =nd the rest of 
the article. You might add ‘continued on page 2’ at the bottom of the article, then 
on page 2 at the top of the article you would add ‘from page 1’. You might use an 
arrow indicating to turn over the page to continue reading.

Typography

Typography refers to the use of various text formatting and font options in the 
production of documents. Using eEective typography allows you to =ne tune a 
document and add the =nishing touches. Remember to ensure you are still able to 
complete your document on time, as some of these design elements can become 
time consuming. 6ere is more to using text eEectively than just choosing a font 
type, font size and text alignment – as shown here.
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Font

The font you choose can have a huge impact on the amount 

of space a passage of text uses. Try typing the same line of 

text in several different fonts and you will see a difference. 

For example, look at the different lengths of the sentences 

below.

 • This is a line of text in Times New Roman.

 • This is a line of text in Arial.

 • This is a line of text in Courier New.

Kerning

Text kerning is a technique you can use to �ne tune the 

way text looks. It involves adjusting the amount of space 

between two characters you have typed. Kerning is normally 

only used in very large headings and its main purpose is to 

avoid the appearance that some letters have more space 

between them than others. In the next example you can 

see that the top line, which has kerning applied, is slightly 

shorter than the bottom line. On close examination the 

major difference is the spacing between the letters in the 

word ‘To’.

 • To kern or not to kern

 • To kern or not to kern

Character space

Another technique you can use to achieve additional 

emphasis on headings is to adjust the spacing between 

all selected characters, rather than just between two 

characters. In the next example the top line has an 

expanded spacing applied, the middle line has no spacing 

applied and the bottom line has condensed spacing applied.

 • Expanded Spacing

 • No Spacing

 • Condensed Spacing
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Practice task 5 

Your company is hosting its annual end-of-year staff party and you have been asked to design 

a �yer to be distributed to all staff advertising the function. Information to be included in the 

�yer is as follows:

Company name: Pack and Go Express Couriers

Date: 16 December 2016

Time: 5.00 pm

Venue: Rush Restaurant and Club

Address: 41 Villa Street, Fremantle

RSVP: 10 December 2014

Dress: Themed party: 80s revival – prize for best dressed

Cost: No charge

Program:

5.00 pm Pre-dinner drinks

6.30 pm Buffet dinner

8.00 pm Awards and novelties

9.00 pm Entertainment – live band

Pictures and logos – select suitable graphics from Clip Art 

Create the document in Word. Ensure you apply what you have learnt in this topic about 

document design and layout when designing it. Save and print your �nished document.
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You should now understand the range of design elements that need to be 
considered when developing a document. 6ese elements form the basis of good 
design and you should work with them, while still adding your own professional 
touches to the layout. 6e most important factor in document design is ensuring 
the information is clear and able to be understood 
by the target audience. Always incorporate your 
organisation’s speci=c design guidelines as well.

A range of so0ware functions is available to 
ensure you produce documents that are consistent 
in design and layout. Using these functions will 
increase your eCciency and help you maintain 
elements of your organisation’s corporate image. 
Using functions such as style sheets can take some 
of the hard work out of document formatting. 
Style sheets are a set of statements that specify 
presentation of a document. Style sheets may 
be written by content providers in style guides, 
created by users or built into so0ware.

Automatic functions

You can use a variety of automatic functions when creating a document to ensure 
consistency. Many of these functions, such as AutoText and AutoCorrect, will 
increase your speed when creating documents.

Useful automatic functions:

• AutoText

• AutoCorrect

• Header & footer

• Table headings

• AutoFormat

• Styles

• Default settings

2C Ensure consistency of design and layout
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AutoText

AutoText is a feature in Word that allows you to enter text by typing just a few 
letters. 6is feature can be used for any passage of text that you need to insert on 
a regular basis. Common uses of AutoText are for creating an entry to insert your 
standard closing onto a letter or fax, or creating an entry to insert your full name 
or company name. Following is an AutoText entry that could be used on letters 
and faxes.

Yours sincerely,

Sue Austin

Marketing manager

Add AutoText to the QuickAccess Toolbar

From the Ribbon choose the File tab, then click Options from the le0-hand 
side menu. 

Click Quick Access Toolbar. 

From the pull-down menu under Choose commands from, select All 
Commands. 

Scroll down to AutoText. 

Click AutoText, and then click Add. 

6e AutoText button will now appear in the Quick Access Toolbar.

Click OK.

Create a new AutoText entry

Select the text that you want to add to AutoText. 

From the Quick Access Toolbar, choose AutoText, click Save Selection to 

AutoText Gallery. 

Fill out the information in the Create New Building Block dialogue box: 

Type in information (see following screen capture) for the AutoText entry. 
Click OK.
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Once you have saved your AutoText entry you can use it by clicking on the 
AutoText icon on the Quick Access Toolbar or, if you remember the name you gave 
it, type in the name (YS SA) and press F3.

AutoCorrect

AutoCorrect is a feature of Word that automatically corrects common typing 
errors. 6is is a powerful tool because of the time it saves when proof reading, 
checking spelling and correcting a document. Have you ever noticed when 
typing that an error will magically correct itself? 6at’s AutoCorrect at work. For 
example, if you type ‘teh’, when you hit the space bar it is corrected to read ‘the’. 
Word has a range of common errors already included as entries and you can add 
your own to these. If you don’t want a word automatically corrected, simply click 
Undo (or press Ctrl+Z).
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Create an AutoCorrect entry

Set up the AutoCorrect feature in the same way as you set up the AutoText feature 
in the previous exercise.

Choose AutoCorrect Options on the Quick Access Toolbar.

Type the incorrect version of the word in the Replace box.

Type the correct version in the With box. (Hint: You could set up an AutoCorrect 
entry for Quick Access Toolbar – this would save typing the full title out as you 
proceed with these instructions).

Click Add.

Click OK.

Remove an AutoCorrect entry

Select AutoCorrect from the Quick Access Toolbar, scroll and select the entry you 
wish to remove from the list by clicking on it.

Click Delete.

Click OK.

Header and footer

Headers and footers are used to add additional information to a document, such as 
the date, time and page number. A header appears at the top of a page and a footer 
appears at the bottom. 6e information that appears in headers and footers is the 
same on every page of a document, or within sections of a document.
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Headers and footers appear on the printed document, but are only visible on 
screen in the Print Layout view or in Print Preview.

Insert a header and footer

From the Ribbon, choose the Insert tab, go to the Header & Footer grouping and 
click either Header or Footer.

Scroll down and view the variety of header and footer styles. 

Choose Blank (+ree Columns). 6e Header & Footer Tools ribbon will appear 
and your cursor will be moved into the document’s header or footer. Move the 
pointer over each of the buttons to see its function.

Note: 6is toolbar is only available if you are in a header or footer.

Experiment with the diEerent Header & Footer Tools (more work will be done 
with headers and footers later).

Click Close Header and Footer to return to your document.

Edit the header or footer

From the Ribbon, choose the Insert tab, go to the Header & Footer grouping and 
click either Header or Footer.

Go to the bottom of the menu and choose Edit Header or Footer.

OR

In Print Layout view, the header and footer will appear as a lighter grey colour. To 
edit the header or footer, double-click on it and it becomes active. 

To exit the header or footer double-click on the document again.
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Tips: using the header and footer tool

From the Header & Footer Tools you can insert:

 • page numbers

 • the date

 • the time with an option to update automatically.

Page numbering produces a more organised document in both hard and soft form. Page 

numbers allow a sequential movement through a document; for example, it is much easier to 

�nd page three than be asked to go to the page with a particular heading somewhere on the 

page.

Many organisations require the date or time to be automatically inserted into documents. This 

helps to track when documents were created or edited, acting as a form of version control.

Ensure that English (Australian) is selected as the language so that the day, month and year 

will be displayed in the correct order, then select a format from the left-hand side.

If you want the date or time to be updated each time you open the document, click Update 

Automatically when inserting the date or times. If this is not ticked, the date or time will not 

change when the document is updated. The Update Automatically feature needs to be used 

with care as it will change to the current date when the document is opened or printed, which 

negates the value of having a date stamp showing when the document was created.

From the Quick Parts button on the Insert grouping, you can insert the following:

 • Fields, which allows insertion of a variety of information; however, the most useful 

category is document information where the �lename, �lepath, author and more can be 

added electronically to the header or footer. Once again this information assists with the 

organisation of documents, version control, document auditing and tracking changes.

 • Building Blocks Organizer, which offers many useful style and design features, including 

watermarks, text boxes and AutoText.

You can also insert Pictures or ClipArt and switch between header and footer or go to header 

or footer in different sections.

Practice task 6

Open a blank document and create a header and footer that contains this information. 

Header: Patrick’s Constructions, 345 Alderly Ave, 

GREENSLOPES QLD 4120

Phone: 07 3455 6320

Fax: 07 3455 6999

Email: reception@patricks.net.au

Footer: Page number formatted as: Page -1-

Auto date formatted as: 12/05/2016 10:22 AM

Change the distance from 

the edge of the page to: 

Header: 0.7 cm

Footer: 1.0 cm

Remember to format and lay out the text so it looks attractive and professional.
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Table headings

You can have tables that are larger than one page when creating documents. You 
can use the Heading Rows Repeat command to automatically show the table 
headings on each page.

You might use this command when you have a document that contains a client list, 
as shown below. 6e column headings have been automatically repeated on each 
page, making the information easier to understand.

Create a Heading Rows Repeat

Note: 6is command only works for automatic page breaks. It will not work if you 
insert manual page breaks within your table.

1. Create a table.

2. Select the rows that you want repeated at the top of each page. You must 
include the =rst row in the table.

3. Click the Layout tab, and then click Repeat Header Rows. 6e heading rows 
will now be repeated on each page.

Note: 6is toolbar is only available if you are in a table.

AutoFormat

6e AutoFormat feature in Word allows application of prede=ned styles to 
documents. 6e styles you can choose from are a standard component of Word. 
You can also create your own templates and styles. 
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Apply automatic formatting

1. To set up AutoFormat go to Customize the Quick Access Toolbar.

2. Go to Choose commands from, then All Commands. Choose 
AutoFormat, Add, OK

3. You can then choose to either:

• AutoFormat now – the default format style will be applied to the 
document.

OR

• AutoFormat and review each change – allows you to choose from a list of 
styles by clicking the Style Gallery button, then choosing a Template. You 
can then Accept All, Reject All or Review Changes.

Styles

When you are creating a document that uses consistent headings and text 
styles, the most eCcient way to format them is to create styles. A style is a set of 
text formatting conditions that are applied to either characters or a paragraph. 
6e advantage of using style sheets is that when you change the style, Word 
automatically changes all characters or paragraphs in the document that use 
that style.

By creating templates with well-organised, sensibly named style sheets, you will 
increase your document production eCciency. You are able to format text in just 
one or two steps rather than having to take several steps each time.

Style sheets are particularly useful for documents that contain a variety of 
headings and text, such as reports. Creating style sheets for frequently used 
documents such as letters, Myers and brochures will save you time because you can 
just apply the style to each paragraph in the document.
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Example: use of styles in a report

The next example shows how three different styles would be used in a report. You should try 

to give your styles meaningful names and in this case Major Heading, Minor Heading and 

Body have been used.

Identify a paragraph’s style

1. Click in the paragraph.

2. From the Ribbon, choose the Home tab. Go to the Styles grouping.

3. Click on the small downwards arrow below the Styles box. 6e Styles window 
will appear. Each style is identi=ed as either a paragraph (marked by the 
symbol: ) or character style (marked by the symbol: a). To apply a paragraph 
style you need to have your cursor at any point within the paragraph; to apply 
a character style you need to have the required text selected.

4. Experiment with using diEerent styles, and changing and modifying styles.

7 July 2016
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Create a new style

1. Select the text you want to create as a new style.

2. From the Ribbon, choose the Home tab, click on the small downwards arrow 
below the Styles box, and a list of styles will appear.

3. Under the list, select the New Style button  on the le0-hand side. 

4. Give the style a name. Click OK.

6is style will then appear in the Styles gallery.

Modify a style

1. Go back to the Styles box.

2. Point to each style and Mag with a brief description of the styles will appear, in 
addition; an arrow indicating a menu will also appear.

3. Click on this arrow and choose Modify.

4. Modify as required. 6e format tile on the bottom le0-hand corner of 
the dialogue box will allow you to format Font, Paragraph, Tabs, Borders 
and more.

5. Choose OK.

6. 6e change will apply to every paragraph or character that has that style 
applied to it.
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Apply a style

1. Click somewhere on the paragraph you want to apply the style to.

2. Go to the Styles section of the Home ribbon.

3. Choose a style from the titles displayed, you will notice as the pointer hovers 
over a title that the style will be reMected in the active paragraph.

OR

Pull down the Styles box and choose a style from the list; you will notice as the 
pointer hovers over a style, its description will appear.

Default settings

By becoming aware of the default settings available in your so0ware, you can 
maximise the eCciency of your data editing. Default settings determine the 
options that automatically appear when you go to perform a task. 

You can change the defaults for a variety of tasks by clicking the File tab, and 
choosing Options. Review the contents of each option until you =nd the setting 
you want to change.

Some examples of defaults you can set are provided below.

Default �le location

 └ The folder that �les will automatically be saved in.

Default printer

 └ The printer a document will be sent to when you click the print 

icon.

Default language

 └ Allows you to set the language for your documents; for example, 

English (Australia).
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Practice task 7 

1. Access and download autoformat-practice.docx at: http://chilp.it/33e7fe0. Practise 

applying the following style sets from the Styles drop-down menu to the document:

 • Manuscript

 • Elegant

 • Distinctive

2. Access and download styles-practice.docx at: http://chilp.it/f2f1f66. This is a project 

update report for a construction company. Create these styles.

Document text Style name

Project update as at 12 February 2012 Report name

Golden Beach Eco Resort

Milne Towers

Beachside Resort Apartments

Report name

Sales

Constructions

Sales and construction

All other body text Details

Practise modifying the formatting of the styles until you get an easy-to-read, attractive layout.

Understand a document’s formatting

One of the greatest challenges you may face when using documents someone else 
has created is working out how they achieved the various eEects. Sometimes it can 
be hard to remember how you did something in your own documents. One of the 
reasons this can be so challenging is that Word provides so many ways to achieve 
the same eEects.

One of the most useful tools in Word is the Show/Hide option. 6e Show/
Hide button  on the Home tab allows you to see the document’s non-printing 
characters. 6e non-printing characters let you see a range of information, 
including where the paragraph ends, where spaces have been placed and where 
the Tab key has been used. When you become familiar with the non-printing 
characters, you can use them to check that the formatting of your document is 
consistent.
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Below are some common non-printing characters.

Paragraph symbol (also known as pilcrow) 

This mark is created when you press the Enter 

key to end a paragraph. In Word a paragraph 

can be several lines of text or just one short line 

with Enter pressed at the end. Word does not 

look at paragraphs like we do; it relies on the 

use of the Enter key to know where they start 

and end.

Space 

This small dot indicates that the Space bar has 

been pressed. You can tell how many times the 

Space bar has been pressed by the number of 

dots.

Non-breaking space 

A non-breaking space can be created by 

pressing Ctrl+Shift+Space. You use a non-

breaking space if you want to ensure that two or 

more words are always printed on the same line 

and never automatically separated by Word’s 

automatic line breaks.

Tab space indicator 

This symbol is used for two purposes in Word. 

It is used to indicate that the Tab key has been 

pressed on the keyboard, and it is also used 

in numbered or bulleted lists as the tab space 

between the number or bullet and the text.

Line break 

A line break can be created by pressing 

Shift+Enter and it is used to start a new line 

without starting a new paragraph. This means 

that when you apply formatting (for example, 

indenting) to the text, Word will treat the lines as 

one paragraph.
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Example: non‑printing characters

This example shows how easy the non-printing characters make it to see how a document 

was created. You can see that several of the effects have been created using an inef�cient 

method that may cause problems if the document is edited at a later date. 

When you look at the document, you can see that the operator has not used good word-

processing practice. The extra spaces, used to create indents, and the manual line breaks will 

not only have taken more time to produce but are bound to become a nightmare for anyone 

who is editing the material. This table lists the mistakes and the correct method that should 

be used.

Mistake Correct method

Incorrect number of spaces between words Only press space bar once between words.

Enter pressed at end of each line in section 

of text that should only be one paragraph

Allow the text to auto-wrap as you type. This 

will ensure that changing the font or other 

formatting will not cause problems later.

Spaces used to indent text Create the text as one paragraph, then 

use the Increase Indent button, in the 

Paragraph grouping under the Home tab.

Changing font size of paragraphs between 

sections of text to adjust the gap between 

lines

Use the Line and Paragraph Spacing 

button, in the Paragraph grouping, 

rather than having a blank line between 

paragraphs.
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Use functions for e5ciency and consistency

Using various text, graphic and page formatting options will help you increase 
your eCciency and consistency.

You should become familiar with each of the following functions: 

• Indentations • Spacing

• Page numbers • Typeface styles, point size and colour

• Captions • Bullets and numbering

• Footnotes or endnotes • Annotated references

• Borders

Indentations

6e indent of a line of text or paragraph is how far it is positioned from the 
margin. Text can be indented on either the le0 or right sides of the paragraph or 
both. Indenting is useful for drawing attention to sections of text. It can be used 
very eEectively to emphasise lists of data, including bulleted lists.

Indent a section of text

From the Ribbon, choose Page Layout, and go to the Paragraph grouping.

Enter the indent amounts and choose the special type if applicable.

Click OK. 

OR

Click the small downwards arrow next to Paragraph on the Home tab and the 
following dialogue box will appear.
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Example: indented text

View the following example to see varying indents.

This paragraph has no indenting applied. You can see that it uses up all the space to both 

margins.

This paragraph has been left-indented by 1 cm, which means that all the text is left-

aligned 1 cm in from the margin.

This paragraph has been right-indented by 1 cm, which means that the text stops 1 cm 

from the right margin.

This paragraph has been indented by 1 cm on the left and right sides. Notice how 

neither edge reaches the margin.

This paragraph has a �rst line indent applied. This style of indent used to be popular 

for letters but is rarely used now, except in books and journals.

This paragraph has a hanging indent applied. That means the �rst line starts on the margin 

and the following lines are indented.

Spacing

Spacing refers to the amount of space around each line or paragraph of text. You 
can set line spacing to be either single, double or a speci=c amount and you can 
also set the amount of space before or a0er a paragraph. Using the spacing option 
allows you to specify exact vertical distances and gaps between paragraphs.

Insert spacing in a section of text

1. From the Ribbon, choose the Page Layout tab. Open the Paragraph dialogue 
box and select the Indents and Spacing tab.

2. Enter the required Before, A7er and Line spacing amounts.

3. Click OK.

Page numbers

As already mentioned, page numbers can be inserted into the header or footer 
of a document. Using a consistent style and position for page numbers helps 
standardise documents and enables the reader to =nd information easily.

Typeface styles, point size and colour

Your word-processing so0ware has many fonts to choose from and you can apply 
a range of sizes, colours and eEects to these fonts. Changing the size or colour of a 
section of text can add impact to your document.
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As you learnt earlier, be careful not to overuse these features as too many fonts 
can make a document hard to read. 6e document type, purpose and audience 
are important considerations in font selection. You would most likely only use 
two to three diEerent fonts, sizes or eEects in a business report, one for the major 
headings, one for the minor headings and one for the body text. However, if you 
were preparing a newsletter or Myer, you may use several fonts to make important 
information stand out and look eye-catching.

6e most frequently used text formatting functions are included as buttons on the 
Home tab.

Change font style

For the full range of font formatting options use the Font drop-down menu.

6is gives you access to additional eEects and a handy preview window so you can 
see how your changes will look before you commit to your choice.

1. Select (highlight) the text to be formatted. 

2. To change the font type or size, in the Font grouping of the Home ribbon 
click on the drop-down arrows beside the font or size buttons and select from 
the list.

3. Bold, Italicise and Underline the font by clicking on the appropriate button.

4. To apply a font colour, click on the arrow next to the Font colour symbol and 
choose a colour from the palette shown.

5. 6e selected text will be changed to reMect your selections.
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Captions

Captions are words you can add to tables, graphic objects, Clip Art and pictures. 
6ey can be used to guide the reader, either to help them identify which graphic 
item you are referring to in the text or give details about something exhibited in 
the text. Captions are used to name diagrams or data in tables (in reports) or in 
newsletters to identify people in photos.

To add a caption:

1. Point to the picture, graphic or table that you want to add a caption to.

2. From the Ribbon, choose the References tab.

3. Click Insert Caption.

4. Select a Label from the list or click New Label to make a new one. 6e label 
you have selected will appear in the caption box. You cannot delete this part of 
the caption at this stage.

5. Click in the Caption box and type your caption.

6. Select the position for the caption, either above or below the selected item.

7. Click OK.

8. To remove the label from your caption, click on the caption that has been 
created and edit the text as you would any text in the document.

Bullets and numbering

Using bullets and numbers to clearly separate points in lists can improve the 
presentation of text. A variety of number formats and bullets are available in 
your so0ware and you can even import pictures to use as bullets. Here are some 
examples of bullets.
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Numbers

Numbers are generally used to denote items that are in order. For 

example, if you were writing a list of the top three sales people for 

an organisation, you could write:

1. James Harker

2. Rose Marcus

3. Peter Jenz

Numbers are also used when creating instructions for people to 

follow.

Bullets

Bullets are used to list items that are not in any particular order 

but need to be shown clearly in a group. 

For example, a company might include a list of staff who attended 

a workshop in the following format:

 • Hank Palmerston

 • Ally Holden

 • Thanh Ng

Format a list

1. From the Ribbon, choose the Home tab.

2. Click on the drop-down menus for Bullets or Numbering in the Paragraph 
grouping.

3. Choose De8ne New Number Format or De8ne New Bullet.

4. Make the desired changes.

5. Click OK.

Footnotes and endnotes

Footnotes and endnotes are used to provide additional information, clari=cation 
or references in printed documents. Footnotes and endnotes are identi=ed by a 
small superscript number a0er the text. 6ey are commonly used when quoting 
a book or website or acknowledging an idea from another source. Footnotes are 
placed on the bottom of the page with the referenced text, while endnotes are 
positioned at the end of the section or document.
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When creating footnotes and endnotes, you must use a consistent style of 
referencing. You will need to ask your supervisor or refer to your organisation’s 
style guide for the preferred referencing format.

Word will automatically assign the footnote and endnote numbers and update 
them should you remove or add any additional footnotes. 

Insert a footnote

1. Move to the position in the document that requires the footnote.

2. Choose References from the ribbon.

3. Select Insert Footnote.

4. You will be moved to the bottom of the page and can type the details for the 
footnote beside the superscript number.

Insert an endnote

1. Follow steps 1 to 2 from the footnote instructions.

2. Click on the small downwards arrow next to Footnotes to launch the Footnote 

and Endnote dialogue box.

3. Choose the location for the endnote, either End of document or End of 

section.
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4. Choose a format for the endnote.

5. Click Insert.

6. You will be moved to the end of the document or section and can type the 
details beside the superscript number.

Remove a footnote or endnote

1. Select the superscript number indicating the footnote or endnote.

2. Delete the number – the footnote or endnote will be deleted.

Annotated references

When you design a document that will be edited by another person, leaving some 
notes or comments to guide them in using the document can be helpful. For 
example, you might tell the document user where missing information needs to be 
entered or give details about the formatting.

6is comment tells the user how the space above the paragraph was created.

Create comments

1. From the Ribbon, choose the Review tab.

2. Click New Comment in the Comments grouping.

3. A comment box will appear and you can type your comment in the box 
provided.

View comments

1. From the Ribbon, choose the Review tab.

2. In the Tracking grouping, click the drop-down menu next to Show Markup 
and check Comments is ticked.

Borders

You can use borders to organise or emphasise parts of a document. In Word, you 
can add a variety of borders to paragraphs, selected text, tables or the entire page. 
Borders can be used in documents such as newsletters to accentuate and draw 
attention to important items; for example, an advertisement for an event.
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When creating promotional documents such as Myers, brochures and invitations, 
the border type selected will contribute to the style of the document. For a formal 
look, choose one of the line styles or, for a fun look, choose an art (picture) border.

Create a page border

1. From the Ribbon, choose the Design tab, then click Page Borders.

2. Select the Setting, Style, Colour, Width and Art. You can choose which sides 
have a border by clicking on the borders in the Preview on the right-hand side.

3. Click OK.

Create a paragraph border

1. Select the paragraph or paragraphs you want a border around.

2. From the Ribbon, choose the Home tab, then go to the Paragraph group.

3. Click the Borders drop-down menu and select Borders and Shading.

Shading

Borders

4. Select the Setting, Style, Colour and Width. You can choose which sides have 
a border by clicking on the borders in the Preview on the right-hand side.

5. Experiment with paragraph shading as well.

6. Under Apply to, select Paragraph, and then click OK.

Consistency with other business documents

Although the functions explained in this topic provide many options for 
formatting word-processed documents, it is important to ensure you follow 
your organisation’s style guide. 6is will guarantee that your documents have a 
consistent appearance and present a professional corporate image.
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Example: organisational style guide

Here is an example of a style guide for Techno Train.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

97

Topic 2
Design word-processed documents

Practice task 8 

1. Make the indent changes in a document as outlined here. Save and print your completed 

document.

This paragraph has no indenting applied. You can see that it uses up all the space to both 

margins.

This paragraph has been left-indented by 1 cm, which means that all the text is left-

aligned 1 cm in from the margin.

This paragraph has been right-indented by 1 cm, which means that the text stops 1 cm 

from the right margin.

This paragraph has been indented by 1 cm on the left and right sides. Notice how neither 

edge reaches the margin.

This paragraph has a First Line indent applied. This style of indent used to be popular for 

letters but is rarely used now, except in books and journals.

This paragraph has a hanging indent applied. That means the �rst line starts on the 

margin and the following lines are indented.

2. Create a blank Word document and insert three Clip Art items of your choice and practise 

adding captions to them.

3. Practise creating footnotes by re-creating the previous example or by inserting them into 

existing documents.

4. Open a blank document and practise inserting comments and displaying and hiding them.

Summary

1. When creating a document, you =rst need to clarify the purpose, audience and 
information requirements.

2. You need to consider a range of design aspects and elements when working out 
the structure and layout of your document.

3. Design concepts need to be incorporated into your documents to enhance 
their readability and appearance.

4. 6e style and layout of documents should follow your organisation’s 
requirements.

5. Create and use styles to ensure headings and text styles are formatted 
consistently.

6. Use automatic functions to increase the eCciency of your work.

7. Use design and formatting functions to ensure consistency of design 
and layout.



98
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

6is learning checkpoint allows you to review your skills and knowledge in 
designing word-processed documents.

Part A

1. Create an A4 Myer advertising the Techno Train Training Centre Open Day. 
Ensure you follow the guidelines in the style guide and use the following 
information. An excerpt from the Techno Train style guide is shown in 
Topic 2, section 2C. Include the Techno Train logo in your Myer, which can 
be accessed and downloaded either by scanning the QR code provided or at: 
http://chilp.it/a646f9f.

Information to be included on the Myer:

Date: 5 June 2014

Time: 9 am – 3 pm

Phone: 07 3876 1333

Email: info@technotrain.com.au

Web: www.technotrain.com.au

Address: 22 Hart Street, CHERMSIDE QLD 4032

Activities:

Meet the trainers

Ask an expert

Short training sessions:

Computer introduction: 45 minutes

Using a digital camera: 45 minutes

RSVP: 30 May 2014

2. Write a one-page report about the document you have created. Include the 
following information:

• A description of the purpose and audience of your document

• 6e design aspects and elements you considered when creating the 
document and how you applied them; for example, white space, graphics, 
boxes, simplicity, balance

3. Research a topic of your choice on the internet and write a one- to two-
page report about it. Examples of topics you could choose include the latest 
fashion trends, a comparison of car makes and models, a new-release movie, 
information about a new so0ware package or computer game.

Your report must include:

• clear descriptive headings

Learning checkpoint 2 
Design word‑processed documents
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• at least two footnotes referencing the websites that were used in your 
research

• a footer showing the page number and the current date

• at least one graphic or table.

Ensure that you create and use style sheets to format your document. Save and 
print your report.

Part B

1. Access and download landscaping-newsletter.docx either by 
scanning the QR code provided or at: http://chilp.it/d727ba2. 

2. Examine the document and list at least 10 design problems 
or errors.

3. Re-create the document using the principles of design and layout you have 
learnt. You can either re-enter all the information or edit the existing =le. Save 
and print your new version.
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Part C

Create a document that allows you to demonstrate using the following functions:

• At least two types of indents

• Two diEerent bullet styles

• At least three diEerent fonts

• A graphic with a caption

• Two examples of borders

Save and print your document.

Part D

1. Give an example of when each of the following automatic functions can 
be used.

• AutoText

• Table headings

• AutoFormat

• Headers and footers

2. List =ve problems you could encounter when creating documents if you do not 
make use of automatic functions.
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Tables are used in documents to display information and can be used eEectively 
when creating forms. Just like most functions performed in Word, you can achieve 
your objectives in several ways. For this reason this unit provides a range of 
instructions for the various techniques available, including right mouse clicks.

In this topic you will learn how to:

3A Insert a standard table into a document

3B Insert and delete columns and rows

3C Insert images and other data
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A common formatting element used in word processing is tables, whereby data is 
presented in rows and columns. A table is very simple to insert and manipulate by 
adding additional rows and columns or by formatting its appearance and contents.

Create a table

1. Move the cursor to where you want the table inserted.

2. From the Ribbon, choose the Insert tab. Select Table.

3. From the pull-down menu you have a number of options to create a table. 
You can:

• Move the pointer over the grid to choose the amount of rows and columns 
that you require – as you do this a preview of your table will appear in the 
document. If you choose not to insert anything this will disappear. 

• At the Insert Table menu tool enter the number of columns and rows, then 
click OK. A table will now be inserted in the text.

• Select the Draw Table option – this allows you to draw the table directly 
into the document.

• You can enter a spreadsheet into the document and input data directly.

• Quick Tables oEers prede=ned templates that you can choose from.

4. You can now click into the cells of the table and enter your data. To move 
between cells, use Tab to move right, Shi7+Tab to move le0, arrows to move 
up and down or click the mouse in the required cell.

Tip: undo an action

When experimenting with the different tools and options remember you can use your 

undo tool on the Quick Access Toolbar or press Ctrl+Z to undo any action.

Select parts of a table

Before you can apply any formatting or manipulate data in any part of a table, you 
need to be able to select the speci=c parts you want to format. 

When you click into the table you have created, you will see a new tab appear on 
the right side of the Ribbon called Table Tools. Under Table Tools, there are two 
sections called Design and Layout. Design gives you access to many diEerent 
design tools such as Shading, Borders and Table Styles. Layout gives you access 
to other features such as inserting or deleting rows and columns, changing column 
width, sorting etc. Spend some time familiarising yourself with the diEerent 
features available in these areas.

3A Insert a standard table into a document



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

103

Topic 3
Add tables and other data

6e following information gives you further details about working with tables.

Select a block of cells

Put your cursor into the �rst cell 

in the block of cells you want to 

select.

Click and drag your cursor over the 

remainder of the block.

Select a row

Move your cursor to the left edge 

of the �rst row to be included 

in the selection. The cursor will 

change to a white  arrow.

Click and drag down the table to 

select the required number of 

rows.

Select a column

Move your cursor onto the top 

edge of the �rst column to be 

included in the selection. The 

cursor will change to a black  

arrow.

Click and drag across the table 

to select the required number of 

columns.

Select the whole table

Move your cursor to the top left-

hand corner of the table. The 

cursor will show a four-arrow 

symbol .

Click the symbol and all cells in the 

table will be selected.

Resize columns and rows

In order to maximise readability and accommodate information needs, it may be 
necessary to resize the columns and rows of the table. 6ere are several methods 
you can use to resize rows or columns, including those mentioned here.

Using the mouse

Move your mouse to the right edge of a column or the bottom of a 

row you want to resize. The cursor will change into a two-headed 

resize
 

 arrow.

Click and drag the column or row to the required width or height.

(Note: This method will change the width of adjacent columns.)
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Using the menu

Select a column or row to resize.

From the Ribbon, choose Table Tools, select Layout. Use the 

pull-down menu, from the Cell Size grouping to access Table 

properties.

Experiment with the AutoFit, Sizes and Distribution (makes all 

columns or rows equal).

If you click the drop-down menu you can click on the Previous 

Column or Next Column buttons to change the width of adjacent 

columns.

Select row and repeat these actions to modify its size.

Using the ruler

This applies to columns only. Move the pointer to the hashed area 

on the ruler to resize. The pointer will change to a double-headed 

arrow.

(Note: This method will maintain the width of adjacent columns.)

Use the Table Tools Design tab

6e Design tab in Table Tools can be used to perform a range of formatting tasks 
on tables.

Note: 6is tab is only available if your cursor is in a table.

Use the diEerent options to experiment with table design and style.

Format table borders

You can apply a variety of diEerent borders to table cells. It is also possible to select 
which parts of one cell have borders displayed. 
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To apply borders

1. Select the cell or range of cells to which you want to apply the border.

2. Click the drop-down  arrow beside Borders to see border options. Click the 
border you want to add or remove.

To change the border style

1. Select the cell or range of cells you want to change.

2. Click the drop-down  arrow beside Borders, choose Borders and Shading.

Format table shading

In addition to adding borders to particular cells, you can also individually select 
block shading of cells.

To apply shading

1. Select the cell or range of cells you want to apply shading to.

2. Click the drop-down  arrow beside the Shading button and then click on the 
shading you would like.

Alternatively use the Table Styles available.

Use the Table Tools Layout tab

6e Layout tab in Table Tools can be used to perform a range of layout tasks 
on tables.
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Note: 6is tab is only available if your cursor is in a table.

Merge and split cells

Merging allows you to join cells together. 6is might be necessary if you want to 
have a title across the top row of the table and a number of columns underneath. 
Splitting lets you break one cell into several parts. 6ere are several ways to merge 
and split cells:

• Go to the Merge grouping in the Layout tab.

• Experiment with the options.

Align the contents of cells

Just as you can set the alignment of text or graphics, you can change the alignment 
for the contents of cells:

• Go to Alignment grouping in the Layout tab.

• Experiment with the options.

Sort

You can sort data in lists or tables into text, number or date order. 6is technique 
allows you to enter data without having to worry about the order; you can take 
care of this a0er the data is entered.

Apply sorting

Highlight the list of items to be sorted.

Choose Sort from the Layout tab.

Choose the sort type from Text, Number or Date. If you are sorting data in a 
table that has a header row, choose either Header row or No header row and then 
click OK.
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Practice task 9

1. Experiment with the different table creation tools. While there might be an instance when 

you could use any of them, you will probably favour one. Once you have created the table 

you will notice that, while your cursor is in the table, other ribbons – Table Tools: Design 

and Layout – will be available to you. Explore these new menus. Save your table so that 

you can use it in the following tasks and activities.

2. Using the table you created, experiment with different border styles and applications.
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6ere may be occasions when you need to add or delete rows or columns in a table. 
Following are instructions for performing these tasks using the mouse and menus.

Using the mouse to insert columns

 └ 1.  Position cursor in the column adjacent to where you wish to 

create a new column.

 └ 2. Click the right mouse button and a menu will appear.

 └ 3.  Select Insert and choose where you wish the new column to be 

inserted.

 └ Note: If you require more than one column, once you have 

inserted one column press Ctrl+Y to repeat the insertion. You can 

press Ctrl+Y for all the columns you need.

Using the mouse to delete columns

 └ 1.  Position your pointer on the top edge of a column and the 

pointer will change to the column select  arrow. Click the left 

mouse button and the column will be selected.

 └ 2.  Click the right mouse button and select Delete Columns. The 

selected column will be deleted.

Using the mouse to insert rows

 └ 1.  Position cursor in the row above or below where you wish to 

create a new row.

 └ 2. Click the right mouse button and a menu will appear.

 └ 3.  Select Insert Above or Insert Below and the new row will be 

inserted.

 └ Note: If you require more than one row, select the number of rows 

that you wish to insert before clicking right mouse button.

3B Insert and delete columns and rows
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Using the mouse to delete rows

 └ 1.  Position your pointer on the left edge of a row and the pointer 

will change to a white  arrow. Click the left mouse button and 

the row will be selected.

 └ 2.  Click the right mouse button and select Delete Rows. The 

selected row will be deleted.

 └ 3. Use the menu to insert or delete rows or columns.

 └ 4.  From the Ribbon, choose the Table Tools tab, and select the 

Layout tab.

 └ 5. Select Rows & Columns.

 └ Experiment with the options.

Practice task 10 

Using the instructions provided in this section, create a table with seven rows and three 

columns. Edit the table so that it is similar to this example. Save and print your document with 

the name ‘Table Practice’.
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One of the advantages of using word-processing so0ware to produce documents is 
that you can import text and data from various programs. Importing information 
saves time by not having to re-enter information. Text and image import functions 
are particularly useful when creating newsletters and reports where the content 
may come from several sources. A range of items known as graphics can be 
inserted into documents. Commonly used graphics include Clip Art, Pictures, 
AutoShapes, Drawing Objects, Graphs and Charts.

You can import data in the following formats into Word:

• Clip Art

• Digital photographs

• Scanned photographs and logos

• Tables, graphs and charts

• Drawing and graphics tools

• Data from other so0ware applications

• Files

• References

• Quotes

Clip Art

Clip Art is the name of a collection of graphics included in Microso0 so0ware that 
can be inserted into documents. Word has a variety of Clip Art images available, 
and Microso0 also has a large database of Clip Art items on oEer for download 
from its website.

Insert Clip Art into your document

1. Move the pointer to the position in the document where you want to place 
the image.

2. From the Ribbon, choose the Insert tab and select Online Pictures.

3. 6e Bing Image Search dialogue box will be displayed. Type a word to 
describe the image you are searching for in the Search box; for example, ‘clip 
art animals’. Results can be Clip Art, Photographs, Movies or Sounds. You 
can choose what types of results should be returned. 

4. Click Search.

5. By hovering the mouse over an image, a magnifying glass will appear and, by 
clicking on it, an enlarged preview of the image will appear.

6. When the list of results appears, click on the image you wish to insert. 6en 
adjust the size and position the image as required.

3C Insert images and other data
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Digital photographs

Inserting photographs into a document is easy when they are in a digital =le 
format. Your word-processing so0ware will recognise a large range of =le formats, 
including Windows Bitmap (BMP), JPEG File Interchange Format (JFIF) and 
Graphics Interchange Format (GIF). Digital photos are o0en used in Myers and 
newsletters.

Insert a digital photograph into your document

1. Move the insertion point to the position in the document where you want to 
place the image.

2. From the Ribbon, choose the Insert tab, and click Picture in the Illustrations 
grouping.

3. Under Pictures library, go to the drive and folder containing your picture, 
then click on the picture you want, and click Insert.

4. Adjust the size and position of the picture as required.

Scanned photographs and logos

When you have a hard copy (printout or 
photograph) of a picture or logo and you want 
to use it in a document, you can import it using 
a scanner. 6e quality of the image will depend 
on the quality of the original hard copy and the 
settings on your scanner.

Insert a scanned image into a Word document

Move the insertion point to the position in the document where you want to place 
the image.

From the Ribbon, choose the Insert tab. In the Text grouping, click Picture. 

Browse to the drive and folder containing your pictures, then click on the picture 
you want, click Insert.

Adjust the size and position of the image as required.

Your organisation’s scanner may be set to save scanned items in a particular folder 
as a graphics =le. You can import these images into your document by following 
the instructions for inserting digital photos.
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Tables, graphs and charts

When creating documents, tables, graphs and charts can be used very eEectively 
to present data. Formatting information as tables, graphs or charts allows you to 
break the monotony of long passages of text.

6e process of importing data from an existing Excel spreadsheet is explained in 
Topic 4. 6e following instructions are for creating a new chart as part of your 
current Word document.

Insert a chart into a document

1. From the Ribbon, choose the Insert tab, choose Chart from the Illustration 
grouping.

2. Choose the style of chart that you wish to insert.

3. 6e following chart and spreadsheet will be displayed ready for you to insert 
your data.

4. Replace the information shown in the sample spreadsheet with your own data. 
Delete any additional information that you do not need.

5. Your chart will reMect any changes made to the data sheet.

6. You can edit the chart or change the chart type by once again double clicking 
on the chart to launch editing mode, then using the Chart menu options 
provided.
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Note: 6is Chart Tools menu is only available if you have a chart selected.

Chart Tools allows you to change the type of chart displayed, manipulate the 
way the data is presented and vary the layout for the chosen chart.

7. 6e Design and Format tabs allow you to change the presentation and layout 
of your chart. From the Format tab, click the drop-down  arrow above 
Format Selection (currently showing as Chart Area in the =gure below); as 
you choose each option from the menu displayed, that part of the chart will 
be selected. 6is will give you the opportunity to familiarise yourself with the 
terminology associated with charts. As each area is selected you can change 
the format.

8. Experiment with the remaining tools in Chart Tools.

Practice task 11 

Open a new blank Word document.

 • Insert a chart using the previous instructions.

 • Enter this data into the datasheet. 

Location May June July August

Melbourne 50 23 43 35

Perth 70 37 22 56

Sydney 90 91 82 67

 • Using the Chart menu, change the chart type to a ‘Line with markers displayed at each 

value’. 

 • Insert a couple of new lines in your document and create a chart using your own data 

(make it up if you want). Choose a chart type that you think looks good and makes the 

data easy to read. Don’t forget to include a title above the chart that describes it.

 • Save the �le as ‘chart practice’.
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Drawing and graphics tools

Word comes with a range of drawing and graphics tools. You can insert pictures, 
Clip Art, Word Art, text boxes or an organisation chart and create shapes 
including lines, arrows, rectangles and ovals. Items created or inserted using 
graphics and drawing tools can serve a range of purposes. For example, they can 
be used to clarify information (such as an organisation chart) or to add interest or 
de=nition using lines or autoshapes.

Insert drawing and graphics tools

1. From the Ribbon, choose the Insert tab.

2. Click on the Shapes menu.

3. Choose a graphic and draw into your document.

4. 6e blue circles and squares allow you to resize, the yellow diamonds allow you 
to alter the shape.

Note: 6e Drawing Tools tab is only available when a drawing is active.

Drawing canvas

6e drawing canvas has advantages and disadvantages. To be as eCcient as 
possible you should use the canvas in any situation where you have more than one 
graphic item that you need to move together. If you are only inserting one item, 
you do not need to use the drawing canvas.

If you are using a graphic or drawing tool and you do not want to keep the 
drawing canvas, hit the ‘Esc’ key on the keyboard when the canvas =rst appears 
and it will be removed. You can then draw or insert the graphic wherever you like.
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6e advantages and disadvantages of using the drawing canvas are outlined below.

Advantages of the drawing canvas

 └ The canvas has its text wrapping properties set to ‘In line with 

text’. This means that the text will wrap around the canvas.

 └ If you insert more than one graphic item onto the same drawing 

canvas, all items will be moved together when you change the 

position of the drawing canvas in the document. This means you 

do not have to group the items.

Disadvantages of the drawing canvas

 └ Word determines the initial size of the canvas. If you are only 

inserting a small graphic, you will need to resize the canvas so 

that there is not a lot of blank, wasted space.

 └ If you insert multiple objects on canvases in the one area of a 

document, the canvases can end up on top of each other and 

make it dif�cult to select some of the objects individually.

Resize and move graphics and objects

1. Click on the object to be resized and resizing handles will 
appear on the corners and sides of the object. Position the 
pointer over one of the handles and the pointer will change to 
the resize  arrow. Click and hold the le7 mouse button 
and drag until you change the object to the desired size.

2. Moving an object is as simple as clicking once on the object, then positioning 
the pointer on the object so it changes to the move  arrow. Click and hold 
the le7 mouse button and drag the object to its new location.

Wrapping style

Positioning pictures and graphics can be one of the most challenging layout 
concepts to master. Everyone has been in the situation where a graphic works and 
drops into position perfectly and also the reverse, where you just can’t get one 
positioned correctly. If you understand how graphics and text wrapping work, it 
can make it much easier to position them eEectively.

Wrapping refers to the way the picture and the text on the page interact. 6ere are 
seven wrapping styles available as shown here.
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Square

This style allows you to move the object around the page and the text 

will wrap around the object. You have the option to allow the text to wrap 

around either both sides, the left only, the right only or largest only. Largest 

only is the side of the graphic with the most space.

Tight

This style is similar to square. However, if the graphic is not square the text 

will wrap in against the edges of the graphic.

Through

Occasionally a graphic may have a gap in the picture. This situation can 

occur where a graphic has been created by using several drawing objects. 

This form of text wrapping will wrap tight around the picture, but text will 

also be placed in any of the gaps.

Top and bottom

Text will be placed above and below the object. No text will appear on the 

left or right sides.

Behind text

The object will be placed behind the text. The text will �ow right over the 

top of the object. This is similar to a watermark effect.

In front of text

The object will be placed in front of the text. Using this option, you may not 

be able to read all of the text.

In line with text

The object will be placed in line with the text. You can select the object and 

move it like you would any section of text.
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Example: image and text wrapping interactions

The following example shows the way the graphic and text interact using each different text 

wrapping style.

Adjust the text wrapping properties of a graphic

1. Click on your graphic and go to the Ribbon, then choose Picture 

Tools, Format.

2. Choose the  Wrap Text button and click on the style you want to apply.

3. Move the graphic into the desired position.
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Move object with text

One of the most important settings for any picture is the option to ‘Move object 
with text’. 6is setting ensures that if you add or remove text from the document, 
the image will be moved with the text that surrounds it.

1. Click on your graphic and go to the Ribbon, then choose Picture 

Tools, Format.

2. Choose Position. 

3. Choose More Layout Options, choose Position.

4. Tick or untick Move object with text.

Tip: image nudging

Have you ever had trouble moving a picture just a little bit? Have you noticed how they 

tend to jump around? You can do what is called nudging (moving the image a little bit at a 

time) by holding down the Ctrl key and pressing an arrow key on the keyboard. The image 

will be moved just a little bit – perfect for �ne-tuning.

Data from other software applications

Due to the variety of so0ware programs available, there is a growing trend towards 
integrating the content generated in them. When the content of packages is able to 
be exchanged, the programs are referred to as compatible.

Many so0ware packages now give users the option of opening a =le that was 
created in a diEerent so0ware package. If you look at the options under ‘Files 
of type’ when opening a document in Word, you will see that the list includes 
WordPerfect and Works and even other versions of Word. 6is means that you can 
open =les that were created using those packages.

You can also save a =le in a format that is able to be opened in another so0ware 
package. If you review the options available under ‘Save as type’ in Word, 
you will see that you can save documents in a format suitable for programs 
including Works. However, because of the diEerences between so0ware packages, 
occasionally some formatting may be lost when this method is used.
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Files

You can insert the contents of a text =le or a =le that you have created in Word 
into a document. 6e contents of the =le you insert will keep its formatting. 6is 
technique can be useful when combining information from several sources, such 
as when you are collecting articles from various authors for a newsletter.

Insert a Ble into a document

1. Move the insertion point to the position in the document where you want to 
place the =le.

2. From the Ribbon, choose the Insert tab, go to the Text grouping, click the 
drop-down  arrow beside Object and click Text from File.

3. Choose the drive and folder and then the =le you wish to insert.

4. Click Insert.

References

References in Word take the form of a 
hyperlink (text or graphic that you click 
on to take you to another location) either 
from one part of a document to another 
part or to an external =le or website. 
Footnotes and endnotes are another form 
of references.

One of the best uses for references is in 
the table of contents of large documents, 
such as reports, which can be hundreds 
of pages long. A reference hyperlink is included in the table of contents so that 
when you press the Ctrl key on the keyboard and click on an item in the table of 
contents, the document will jump to that position.

Create a table of contents

1. Move to the position in the document where the table of contents will be 
positioned.

2. From the Ribbon, choose the References tab and select Table of Contents. 
6en choose one of the built-in options, or at the bottom of the menu you can 
choose Custom Table of Contents.

3. Choose any option.

4. To jump to a heading in the document, hold down the Ctrl key and click on 
the item in the table of contents.



120
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU303
Design and produce text documents

Quotes

To add impact or weight to the contents of a document you may wish to use the 
thoughts or words of others. As well as the required referencing and footnotes, you 
may wish to add emphasis by indenting the quote, italicising or altering the font. 
You may =nd that your organisation’s policies and procedures will provide you 
with direction on this.

Practice task 12 

1. Open a new blank Word document.

 • Insert a Clip Art graphic by performing a search for ‘Clip Art computers’.

 • Add a caption below the graphic that says ‘Employee using new computer’. (You can 

add a caption by right clicking on the image and selecting Caption.)

 • Find and insert three other Clip Art or photographic items, which you have searched 

for, into the document. Add descriptive captions to each of the graphics. Type a line 

above each image stating what words you used in your search to �nd the Clip Art or 

photographs.

 • Save the �le as ‘Clip Art Practice’.

2. Open a blank Word document.

 • Access and download section-break-task.docx at: http://chilp.it/0cce1ea.

 • Access and download columns-task.docx at: http://chilp.it/9e74361.

 • Put the content of both �les into the new blank Word document.

 • Take note of what happened to the information you inserted and write a brief 

description of any changes in formatting or layout of the information you inserted.

3. Open a document that contains a number of headings over several pages. 

 • Insert a blank page at the start of the document and create a table of contents. 

 • Practise moving to the various sections of the document using a Ctrl+click.

Summary

1. Create and manipulate the layout of a table.

2. Format and enhance the design of a table.

3. Insert and manipulate graphics into a document.

4. Use and manipulate drawing and graphic tools to clarify information.

5. Enter and import text to enhance your documents and import data from other 
so0ware applications.

6. Use referencing eEectively.
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6is learning checkpoint allows you to review your skills and knowledge in adding 
tables and other data.

Part A

Produce a document similar to the following example. You will need to search for 
similar Clip Art images to use in the document. Your document should use the 
same layout (positioning of text and images), similar heading styles, tables and 
margins. Ensure you create appropriate styles to support the formatting of the 
document. Save the document as ‘Capricorn newsleter.docx’ and print it.

Learning checkpoint 3 
Add tables and other data
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Part B

1. Create a document.

2. Access and download gym-roster.docx either by scanning the QR code 
provided or at: http://chilp.it/01ba147.

3. Design a Myer to hang on the noticeboard in the dressing rooms.

4. Find suitable graphics.

5.  Key in and format the information. Save as ‘Asp ch3 Table 1’ 
and print the document.

6.  Reformat the table to create a diEerent emphasis. Print and 
save as: Asp ch3 Table 2.

7.  Compare the two documents and write a report discussing 
the changes that you made, how you wanted to change the 
emphasis of the document, and if you achieved it.

Part C

1. Access and download shepherd-street-gym.docx by either scanning the QR 
code provided or at: http://chilp.it/fc51e82. You will =nd text that needs to be 
formatted into a Myer for a gym. 6is Myer will be mailed to every household in 
the area.

2. Create a Myer for this gym.

3.  Find a quote from a newspaper, website or health 
magazine to add.

4. Find suitable Clip Art.

5.  Find a photo that could be the gym and draw a map (it is at 
the corner of Baylis Street and Shepherd Street).
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In this topic we will review the importance of editing, printing and storing 
documents, and using so0ware functions to ensure that documents are produced 
in the most time- and cost-eEective manner.

6e advanced functions explained in this topic will allow you to streamline your 
operations so that consistency of your =nished documents can be assured.

In this topic you will learn how to:

4A Use advanced so0ware functions

4B Enter, import and edit text and other data

4C Preview, adjust and print documents

4D Name and store text documents and exit the application safely

4E Prepare text documents within designated time lines

4F Overcome problems with document design and production
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Word-processing so0ware programs contain hundreds of so0ware tools to assist 
you in creating and editing documents. Knowing which functions to use for 
various text eEects ensures you can create professional looking documents and 
complete your work eCciently.

Just like any trade, the more tools you have available the easier it is to get the job 
done. If you complete tasks using the correct formatting and functions, your 
colleagues will be able to easily edit and make changes to the documents you have 
created. For example, if you did not know how to use section breaks to change the 
number of columns on a page and you had incorrectly used two tables to create 
the same eEect, the next person to use the document would have to reformat the 
contents correctly into two columns. A lot of valuable time would be wasted.

Advanced word-processing so0ware functions:

• Sections

• Columns

• Templates

• Tables

• Alternate headers and footers

• Styles

• Importing data, objects and pictures

• Drawing and graphics tools

• Sort

• Mail merge

Sections

Sections are used to separate parts of the document with a diEerent layout, such 
as margin size, page orientation or number of columns. 6ey allow you to have 
control over the =nal look of your document. For example, if you want to produce 
a document that has one page in portrait orientation but the next page would be 
better in landscape, you would use a section break.

To achieve various eEects, there are a range of section break types available, which 
are described here.

4A Use advanced software functions
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Next Page

A new page is started and the new section starts on this page. 

This option is useful for having more than one page orientation 

in a document. You can insert a Next Page section break, then 

change the page orientation on one of the pages from portrait to 

landscape or vice versa.

Continuous

A new section is inserted on the current page. This technique is 

used to create pages with more than one column format or with 

different margins on different parts of the page.

Even Page or Odd Page

A new page section is started on the next even or odd numbered 

page depending on which command you choose. Additional pages 

will be inserted into the document as required. This technique is 

used in books where each new chapter must start on either an 

odd or even page consistently throughout the document.

Insert a section break

1. Move to the position in the document where you would like the section break 
inserted.

2. From the Ribbon, choose the Page Layout tab, then pull down the 
Breaks button.

3. Select the type of break you would like from Next Page, Continuous, Even 

Page and Odd Page options.

4. Click OK. A section break will be inserted and will look similar to the 
following.

5. You can only see section breaks when the non-printing characters are on 
display. Click the Show/Hide  button to show them.
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Example: section breaks

The following example illustrates how section breaks are used.

In this example, the �rst 

continuous section break 

is used to change from 

one column for the major 

heading, ‘Capricorn State 

School’, to two columns 

for the information 

underneath.

The second continuous 

section break is used to 

change from two columns 

to one so that the larger 

article is presented in an 

easy-to-read layout.

Continuous section breaks

Know which section you are in

To check which section you are currently in, look at the status bar at the bottom of 
the screen. 6e section number will be shown as ‘Section’ followed by the number; 
for example, Section 1, as shown here.

If you do not have the information above on your status bar – the bar right at the 
bottom of your Word screen and above the Windows Task Bar – point at it with 
the pointer, click your right mouse button and add in the features you would like 
to have on your status bar.

Remove a section break

1. Move the cursor so it is positioned before the section break.

2. Press the Delete key on the keyboard and the break will be removed.
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Styles

As already explained, styles are used to maintain consistency in text formatting 
throughout a document. When combined with the use of functions such as section 
breaks and columns, it becomes very easy to create professional documents.

Columns

Columns have a variety of uses, particularly in designing forms, newsletters and 
brochures. You can use several formats and options when creating columns. You 
can divide your page or section into a number of even columns, or columns of 
diEerent widths; change the spacing between columns; and choose whether or not 
to include a line between the columns.

Unless you have speci=ed otherwise, new documents created in Word will 
automatically be formatted with one column.

Using columns is an important aspect of dealing with layout changes in Word. It 
gives the option of setting the exact parameters of how much of the document will 
be aEected.

Change the number, width and spacing of columns

1. From the Ribbon, choose the Page Layout tab, go to the Page Setup grouping 
and click on the drop-down arrow under Columns.

2. Select one of the pre-set column options.

OR

Go to More Columns and enter the number of columns and Width and 
Spacing manually.

3. Select the appropriate option under Apply to. Choose Whole document, +is 

section or +is point forward.

4. Click OK.
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Practice task 13 

Using a document that contains large blocks of text, make the following changes.

1. Change the page layout to have two even columns using the Columns button via Page 

Layout on the Ribbon.

2. Using the Columns button, experiment with the various column styles, including number 

and width of columns, line between, and left and right column options.

3. Return the document to its original one-column format. Then apply the functions and 

design skills you have learnt so far to create an attractive one-page newsletter. Ensure you 

adjust the margins and have at least two sections with different numbers of columns on 

the page.

4. Save your work.
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So0ware packages enable users to integrate data from a range of sources. Microso0 
OCce allows the user to import and export data between the various packages. A 
common use of this function is to import data from an Excel spreadsheet into a 
Word document. Data can be imported as an object from one program to another, 
saving a lot of time.

Insert an object

1. From the Ribbon, choose the Insert tab, click Object in the Text grouping. 
6en choose Object from the pull-down menu.

2. Click the Create from File tab, click Browse.

3. Locate the drive and folder containing the data you wish to import, and 
doubleclick on the =le name.

4. Click OK. 6e =le will be placed into your document. Sometimes the object 
that is inserted will be too big so you may need to resize it and then edit it to 
ensure the correct data is displayed.

Edit imported data

To edit the object you have imported, double-click on it and you will be in editing 
mode. 6e tools you have available to edit an object will depend on the program 
that the object was created in. You will generally have a lot of the same functions 
you had when you created the object in the original program. In the next section 
we examine editing an object created using Excel.

O0en Excel worksheets will contain a number of rows and columns of data. You 
may not want all the data to be shown in your Word document, so you may need 
to adjust the range of cells that are on display.

Double-click on the Excel object to enter editing mode. You will be presented with 
a ‘mini’ version of Excel complete with the various worksheets and scroll bars for 
moving through the data. Below you can see that we do not need the blank rows 
and columns to be displayed.

4B Enter, import and edit text and other data
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Hide column and rows

To hide any data that you do not want displayed (for example, blank rows or 
columns), use the cropping handles on the sides and corners to click and drag to 
adjust the size of the area displayed. Below the display area has been adjusted so 
that the blank rows and columns are now hidden. While in editing mode you can 
also change the data on your spreadsheet.

When you have =nished editing your object, simply double-click anywhere outside 
the object on your document and the object will once again appear like a graphic. 
You can now resize the object to meet your needs.

Templates

Templates are saved style guides that 
are used to create frequently produced 
documents. Most organisations have 
templates for letters, faxes, memos, 
minutes and agendas. 6ey may also 
have templates for reports, Myers and 
brochures.

Templates are special =les that are not 
stored with the rest of your documents. 
6is is so Word knows where to =nd them so they can be accessed when creating a 
new document. You can see where your templates are being stored by checking the 
default =le locations.

Check Ble location

1. From the Ribbon, choose the File tab, click Options on the le0-hand 
side menu.

2. Choose Trust Center, Trust Center Settings, Trusted Locations, and you will 
see the =lename and =lepath of where your templates are stored.

3. You can manage your templates from this area.
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Create a template

1. From the Ribbon, choose the File tab, click New.

2. Select Blank document from FEATURED.

3. Create and format the template that you require.

4. Click File, Save As, then choose Browse.

5. In the Save as type box, select Word Template (*.dotx).

When you save the new template, it will be saved to the Trusted Location that you 
found earlier.

Tip: change and use a template

If you need to make changes to a template you have created, make sure that you are 

opening a template and not a document by changing the All Files setting in the Open 

window to Word Templates. If you look carefully you will also see that templates and 

documents have slightly different icons beside the �le name.

So that you don’t accidentally make changes to your template, ensure you always 

remember to create a document based on the template when creating new �les. 

Create alternate headers and footers

Headers and footers are used to display information on each page of a document. 
When creating large documents, such as reports or booklets, you may be required 
to display diEerent information in the headers and footers of odd and even pages. 
You will o0en =nd examples of alternate headers and footers in books. 

1. Open your document.

2. From the Ribbon, choose the Insert tab, select the Header or Footer option to 
insert a header or footer from the Header & Footer grouping. 6e Header & 

Footer Tools will appear.

3. Choose Di=erent Odd & Even Pages in the Options grouping.

4. You will now see that the header and footer names have changed to Odd Page 

Header and Even Page Header and appear similar to the following image.
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5. Enter the information required into the odd and even headers. 

DiDerent Brst page header and footer

Another option that is available when working with headers and footers is to have 
a diEerent =rst page. 6is is useful when creating documents that have a title page 
where headers and footers would not be displayed.

Follow the previous instructions to open Header & Footer Tools tab, and click 
Di=erent First Page.
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Practice task 14  

1. You work for Total Accounting Solutions and your supervisor has requested that you create 

new letter and fax templates. The following guidelines need to be followed when designing 

and creating the templates.

 • Organisation name, address, phone number, fax number and email address are to be 

included in the header.

 • Organisation details:

Total Accounting Solutions

PO Box 459

CAULFIELD VIC 3185

Phone: 03 9847 6651

Fax: 03 9847 6612

Email: info@totalaccounting.com.au

 • The company slogan is to be included in the footer of both documents.

 • Company slogan is: ‘Helping you through accounting and �nancial advice’.

 • Left and right margins should be no more than 2 cm.

 • Top and bottom margins should be no more than 1.5 cm. 

When you have �nished, save your templates as ‘TAS Letter template’ and ‘TAS Fax 

template’.

2. Open a blank Word document and create alternate headers and footers. Save your 

document as ‘Headers and Footers Practice’.

Create a mail merge

Mail merges allow you to combine the contents of two =les, one that contains the 
information you are sending and one that contains the details of the recipients. 
Mail merges can be used for personalising letters, reports, faxes and Myers. 

6e easiest way to learn about mail merges is to work through the process of 
completing one. 

Here is a summary of the steps to follow when creating a mail merge.

1. Go to Mailings in the Ribbon, click on the Start mail merge button and then 
select Step-by-Step Mail Merge Wizard.

2. Select the Document Type.

3. Select the starting document to use for the merge.

4. Select the recipients (data source).

5. Write your letter.

6. Preview your letter.

7. Complete the merge.

8. Save the document.
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Practice task 15 

Create the mail merge outlined below.

1. Open a new blank document in Word. 

2. From the Ribbon, choose Mailings, click on Start Mail Merge then select Step-by-Step Mail 

Merge Wizard. The Mail Merge task pane will appear. At this point, the Mail Merge Wizard 

allows you to select the type of document you are working on. You can choose from letters, 

email messages, envelopes, labels and directory.

3. Select Letters from Select document type task panel. Click Next: Starting document. Now 

you need to set up your letters. Under Select starting document, there are three options: 

 • Use the current document

 • Start from a template

 • Start from existing document

4. Select Use the current document. Then click Next: Select recipients. The recipients are the 

people who will receive the document. 

In the Select recipients panel, you are given three options:

 • Use an existing list – choose this if you already have a recipient list or data source 

available

 • Select from Outlook contacts – choose this if you have pro�les set up in Outlook

 • Type a new list – choose this if you have not previously created a data source or 

recipient list

5. Select Type a new list. Then select Create from the Type a new list panel.

6. To create a recipient list, you need to set up or customise your columns. To do this, click 

Customize Columns. In the Customize Address List, you can add, delete or rename �elds or 

columns by clicking Add, Delete or Rename. Then click OK. 

continued …
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… continued

Practice task 15 

7. Create a recipient list with the following information. Remember to customise your address 

list �rst.

Company

Name

Address City State Post 

code

First 

name

Surname Current

Henderson 

Printers

PO Box 

522

MAROOCHYDORE QLD 4558 Alex Bolton $10000

Ingles 

Accounting

28 

Melville 

Street

NOOSA QLD 4566 Susan McFee $4000

John 

Marcus & 

Sons

PO Box 

193

BEERWAH QLD 4519 John Marcus $8000

8. Type these details into the �elds. When entering data, you can either click into each �eld 

using the mouse or use the Tab and Enter keys on the keyboard to jump from �eld to �eld.  

To create a new record, click New Entry after you have entered a record. When you have 

�nished entering all the details, click OK. When you do this, you will be prompted to save 

the list. Choose an appropriate location for the list �le. Choose an appropriate name for 

the recipient list. Click Save.

Word has a range of default locations for saved �les. The default location for data sources 

is Libraries\Documents\My Data Sources. When you insert or save a data source, this is 

the location Word will automatically look in. If you have an existing recipient list, when you 

choose Use an Existing List from the Select recipients panel, the browse tool’s default 

location is also Libraries\Documents\My Data Sources.

After you have saved your recipients list, when you open this �le the information appears 

in the Mail Merge Recipients window. In this window, you can choose which entries to 

include in the mail merge by checking (ticking) or unchecking the box beside the �rst �eld. 

This option is useful because data sources or recipient lists often contain hundreds of 

records.

continued …
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… continued

Practice task 15 

9. Ensure all recipients are checked. Click OK. Then click Next: Write your letter.

10. Now type and format the following letter, include the de�ned merge �elds. To do this, 

move the cursor to the position in the document where you want the �eld, then click the 

Insert Merge Field button from the Mailings toolbar. Select the �eld you want to insert. 

Repeat for each �eld.

continued …
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… continued

Practice task 15 

11. Click Next: Preview your letters. A Preview your letters panel will appear. Use the forward 

and backward arrows in the panel to preview each letter. When you click an arrow, the 

document on the left-hand side should be updated with the record. 

12. Click Next: Complete the merge to complete the merge. There are two options provided to 

complete the merge: Print or Edit individual letters. 

Both options ask you which records you want to merge and you can select from All, 

Current Record or From/To. If you choose Print, you need to nominate which records you 

want to print before you send them to the printer. If you choose Edit individual letters, 

you will be asked which records you want to merge to a new document. The letters will be 

displayed on the screen so you can check them before printing. The letters are displayed 

together in a new document called Letters1.

13. Click Edit individual letters. Select All and click OK.

14. Review the letters. When you are sure they are correct, choose Print.

15. When saving the document, make sure you save the source document with the merge 

�elds not the Letters1 document. This is important if you wish to use the same letter 

at some stage in the future. Select the File tab, choose Save As. Save the �le to an 

appropriate place on your computer or network server.

Edit documents

One of the essential phases in producing any text document is editing. Having 
produced a dra0 of a document or accessed an existing document, the next step 
is to review and edit the document to ensure it meets organisational and task 
requirements. You need to check the style and layout of the document and you 
must also check the spelling, grammar and punctuation.

Many organisations have a checklist to help people systematically go through the 
points that need to be considered before a document is =nalised. Your organisation 
may have some special requirements that need to be checked as part of the editing 
process, so make sure you are familiar with these. 

Below are some aspects to keep in mind when editing and proofreading 
documents.

Document type

 └ Ensure you have selected the correct type of document. For 

example, when asked to collect some information, do the results 

need to be presented in a report or can they go into a memo?

continued …
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… continued

Audience, purpose and contents

 └ Is the document you have produced suitable for the audience 

and purpose? Is it formal or informal enough? Is the language 

appropriate? Is there too much jargon? Is all the required 

information included? Is it presented in an easy-to-understand 

format?

Spelling

 └ Never rely on the spellcheck function on your computer. It only 

identi�es spelling errors, not incorrect use of words. Words 

may also be spelt in different ways; for example, American and 

Australian spelling for words such as organize/organise. Check 

the in-house style manual.

Grammar and punctuation

 └ Grammar and punctuation suggestions made by software 

applications are not always accurate. Check them yourself before 

adopting the suggestion. 

Style

 └ Ensure you have used the correct template, if one is available. 

Have you followed the guidelines in the organisation’s in-house 

style manual, including use of logos and fonts? Is the style 

consistent? Make sure headers and footers are correct and 

spacing is consistent throughout; for example, 10.30 am is 

always written in the same way (not 10:30 a.m. or 10.30am). 

Check the in-house style manual. 

Numerical and statistical data is accurate

 └ Match your document with the original �gures you were given. It 

is very easy to make a mistake when entering a lot of numerical 

data into a document.

Edit and proofread tools and symbols

Editing and proo=ng symbols are used on hard copies of documents to indicate 
where changes should be made. 6ey are a bit like shorthand, as they are much 
quicker and take up less space on the page than writing instructions in longhand.
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6e Style manual for authors, editors and printers (Snooks & Co., John Wiley & 
Sons) is the standard reference used by the Australian Government. It provides an 
extensive discussion of editing and proofreading symbols and their use, as well as 
other editing and formatting issues. Some organisations also have their own in-
house style manuals.

You need to be familiar with both common and non-standard editing symbols 
so that you can easily interpret the changes suggested by others. 6is table shows 
some common editing marks.

Instruction Mark in the text Symbol

Delete Strike through text to be deleted:

Delete this this word

Insert Place a ‘caret’ in the text where you want to insert 

something: 

Insert  here

Insert space Place the caret where you want the space to be:

Maintain accurate  records of all transactions

Insert hyphen Place the caret where you want the hyphen to be:

Don’t throw away once  used paper

Close up – delete 

space between 

characters

Draw half circles to link the characters:

Sent ence

Leave as printed 

– ‘stet’ means to 

ignore the edit 

and leave it as it is

Draw a dotted line under the characters you have 

deleted:

The meeting is

scheduled for

stet

Wrong font – 

replace by letter 

of correct font

Circle the character to be altered:

Cooperation is very important

w/f

Change to capital 

letters

Draw three lines under the characters to be altered:

The appointment is for mrs roberts

caps

Change to lower 

case

Draw a line through the characters to be altered:

Take regular BReaks from your work

l.c.

Spell out 

abbreviation in full

Circle the abbreviation:

It is a good eg of best practice

spell out

Transpose Draw a line to where the letters or words should be:

Put paper here that is  

used only on one side

trs
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Tips: editing

Where possible, allow enough time to complete the draft of a document and then put it 

aside and work on another task before performing the �nal edit. Often when we work on 

a task for a long period of time we no longer read what is there; we read what we think 

should be there. It may only be a word or two or a �gure that is different, but this can be 

crucial if it’s the wrong word or �gure.

Read the document out loud. This may sound strange but it is a great way to ensure that 

it reads correctly and that words have not been missed.

Example: not checking work thoroughly

Nancy is an administration assistant working for a supplies �rm. She has just �nished 

typing up the monthly sales report. She considers herself very ef�cient and has completed 

this task on a regular basis for the last six months. She sits down and proofreads the 

report, picking up a couple of formatting errors, but is con�dent it is ready to go. She puts 

a copy in the manager’s tray and then proceeds to make 100 copies to distribute at the 

sales meeting.

Peter, another employee, comes over to the photocopier and picks up a copy of the report 

while waiting to do his own copying. He reads the �rst paragraph and sees that it mentions 

an increase of 50 per cent in new sales, when he is sure the 

manager’s memo on the subject mentioned an increase of 

only 15 per cent.

After a quick glance at another section of the report he 

notices the name of a valued client, ‘Mrs Paula Mart’ 

has been mistyped and reads, ‘Mrs Paula Nart’. Peter 

approaches Nancy regarding the errors and suggests that 

the report needs further proofreading. Nancy is shocked and 

says she will re-read the report right away and correct any 

errors.

Practice task 16 

Work through the following task to practise importing and editing an Excel worksheet.

 • Open a new blank Word document.

 • Access and download client-fees.xlsx at: http://chilp.it/d68ee79.

 • Import this Excel �le.

 • Edit the object by double-clicking on it.

 • Resize the object so that it �ts on the page.

 • Change the Chart 1 sheet. Resize the object so that it uses the full width of the page.

 • Edit the object so that the Client Fees sheet is showing.

 • Resize the object so that the data takes up no more than half the width of the page.

 • Practise switching between the sheets and resizing the object to change the data that 

is on display.

 • Adjust your page so that it appears as follows. Save and print your work.
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When creating a document, it is important to use print preview to see how it will 
look when printed. Print preview is particularly useful for checking the design of 
your document to ensure it adheres to the intended design principles. Using the 
onscreen print preview also helps to conserve resources by reducing printer ink/
toner and paper usage. When a document contains a lot of colour, which can be 
expensive to print, you can reduce printer ink usage signi=cantly by only printing 
the =nal dra0.

Your organisation may have guidelines for printing highly designed documents 
in order to keep costs down. 6ese guidelines may include using print preview or 
changing the printer settings to dra0 or greyscale for dra0 versions of documents. 
Using these dra0 settings will reduce ink usage.

Use print preview

Print preview allows you to view a document as it will appear when printed. You 
can activate print preview by clicking the File tab and choosing Print. 6e print 
preview will be automatically shown in the right panel. You can use the zoom bar 
to zoom in or out on your page. 

By using the zoom bar at the bottom of the page, you can view several pages 
at once.

As you will o0en be using print preview, it may be worth adding it to the Quick 
Access toolbar.

4C Preview, adjust and print documents
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Print documents

6ere is a range of options available when printing documents. Most of the time, 
the document is printed as it appears on the screen, but you can also apply any of 
the following options:

• Print merge

• Print to =le

• With comments

• With drawing objects

• With =eld codes

• With hidden text

Print merge

When merging documents; for example, in a mail merge, you will have the option 
to perform the merge to the screen or to the printer. Simply select the printer if you 
want them printed immediately.

Print to Ble

1. 6is option is used when you need to take a document to another computer 
that may have a diEerent type of printer. No hard copy of the document will be 
produced, just a =le that can be saved to disk or emailed.

2. From the Ribbon, choose the File tab, then select Print.

3. From the =rst drop-down menu under Printer, select Print to File.

4. Click Print. Select a Save in location for the new =le, then select the Save as 

type. Type a name for the =le, then click OK.

Print with comments

You can print the comments applied to a document – these may give the reader 
additional information on how the document was constructed or brieMy clarify 
information in the document.

1. From the Ribbon, choose the File tab, then select Print.

2. From the =rst drop-down menu in Settings make sure there is a tick next to 
Print Markup.

3. Click Print.
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Print with drawing objects

6is setting is usually turned on automatically when you create a document. 
However, if you have a document that contains a lot of drawing objects that you 
don’t want to print in the dra0s, you can de-select the ‘with drawing objects’ 
option using the instructions below and the objects will not be printed. 

1. From the Ribbon, choose the File tab, then select Options.

2. Click Display from the le0 menu.

3. Click the check box next to Print drawings created in Word and click OK.

4. From the Ribbon, choose the File tab, then select Print.

5. Click Print.

Print with Beld codes

Field codes are used to tell Word what information needs to be inserted into a 
particular place in a document. Field codes are used to insert the merged data 
when creating merged documents.

1. From the Ribbon, choose the File tab, then select Options.

2. Click Advanced from the le0 menu.

3. Scroll down to the Print section. Click the check box next to Print 8eld codes 

instead of their values and click OK.

4. From the Ribbon, choose the File tab, then select Print.

5. Click Print.

Print with hidden text

Text may be included in a document that you want to view on screen but not 
to print. If you have hidden the text using the font settings, you can make the 
computer print the hidden text by following these instructions.

1. From the Ribbon, choose the File tab, then select Options.

2. Click Display from the le0 menu.

3. Click the check box next to Print hidden text and click OK.

4. From the Ribbon, choose the File tab, then select Print.

5. Click Print.

Practice task 17 

Open a document or documents you have created using text, drawing objects, comments and 

�eld codes, and experiment with print previews and selecting and de-selecting the various 

print options that have been discussed.
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An important task when creating and editing documents is saving your work. 
Saving the document ensures that you can edit or print it again when required. 
Each organisation has its own policies regarding the naming and storing of 
documents and it is important you 
follow these procedures so that you 
and other staE can access the 
documents as required.

Most documents you create 
will be stored electronically and 
occasionally hard copies (printouts) 
of the documents may be stored 
in the organisation’s paper-based 
=ling system.

Electronic Ble storage

Each document needs to be easily identi=able. Your organisation is likely to have 
an established system for naming electronic =les to ensure all employees are able 
to =nd =les when they are required.

Folders are used to organise =les so they are easier to locate. Each organisation 
uses folder structures and naming standards to ensure that all =les are stored in 
the correct location. If your organisation has a network, you may have shared 
directories and folders that several staE may have access to. 

6e advantages of using shared directories and naming standards include the 
following.

Advantages of shared directories and naming standards

Organised �les are easy to �nd. For example, it is much easier to �nd one 

�le in 20 than it is to �nd one in 100.

If an employee is away, other employees can check to see how much of a 

document the employee has completed and �nish it if necessary.

Work is less likely to be duplicated as staff can check if there is already a 

document created.

It is easy to share documents between employees.

4D Name and store text documents 
and exit the application safely
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Files stored in shared directories are normally backed up on a regular 

basis.

Virus scans are normally run on shared folders on a regular basis.

To set up a shared directory, you have to �nd the shared network drive. 

Then go to the folder level. This is the �rst place to organise the directory.

Folders have a treelike structure that branches from a parent directory to 

sub-folders in a hierarchical structure.

Example: hierarchical directory

In this structure the server has three folders for three separate workgroups: Group A, Group 

B and Group C. Group C has three major folders: Procedures, Personnel and Projects. The 

Projects Folder has three folders: Project A, Project B and Project C. The Project C folder 

has two documents: ProjectC_timelines.docx and ProjectC_research1.docx. The �le path for 

retrieving a document starts at the server and ends when the correct document is located. 

For example, to reach the ProjectC_timelines.doc the �le path is: C:\GroupC\Projects\

ProjectC\ProjectC_timelines.docx.
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Practice task 18 

Look at the previous example. Imagine that you belong to Group C.

1. You want to add another time line document for Project A to your shared directory. Write 

out the �le path you would use to place it in the correct location. Decide on an appropriate 

name for the document.

2. Describe four advantages of using a shared directory.

Manage shared directories

When you have access to a shared directory to store your =les, you may also have 
access to =les created by other employees. It is important that you check your 
=les and delete any that are no longer required on a regular basis to ensure the 
system remains eCcient. If you are planning to have a clean-up of your =les, check 
with your supervisor, before you delete any, which projects or clients you need to 
keep =les for. You should never delete or move =les created by another employee 
without their permission, always check =rst.

Organisations usually perform 
regular backups of shared 
directories and folders. In larger 
organisations a staE member from 
the IT department will usually 
be responsible for this. If you are 
planning to delete a lot of =les, it 
may be a good idea to perform a 
backup of the =les (which can be 
kept before deleting them).

Hard‑copy storage

Many documents stored digitally are also stored in hard copy. 6is is a safeguard 
against a catastrophic computer system failure. Hard-copy storage requires space. 
It also requires a =ling system that uses consistent, simple and meaningful names 
similar to those used in digital storage.
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Managing hard-copy documents is necessary to 
eCciently use storage space. Retention schedules are 
used to determine which documents need to be kept 
and for how long. Documents without permanent value 
may be scheduled for eventual destruction. It is normal 
oCce practice for staE to perform archiving duties; that 
is, removing inactive =les and placing them in long-
term storage when there is not much other work to do. 
Retention schedules save space because only a limited 
number of records have long-term value. 6e development and implementation of 
a retention schedule also saves money, as it means that only records of enduring 
value will be permanently retained. Some documents need to be retained for legal 
reasons; for example, taxation details need to be retained for at least six years.

Example: retention schedule 

Following is an example of a retention schedule.

Retention schedules for hard-copy documents

Credit card receipts and statements 2 years

Tax records 6 years

Accounts records 6 years

Invoices 1 year

Client correspondence 2 years

Unsolicited CVs 6 months
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Practice task 19 

Read the case study, then complete the tasks that follow.

Case study

Craig has retired from an organisation after working as an administrative assistant 

for 10 years. At work he had been responsible for two areas: Accounts and Projects. 

The day after he retired, somebody urgently needed a �le that Craig had created and 

stored. The �le contained vital accounting information. It was discovered that Craig had 

saved over 500 �les in a variety of folders and the �le could not be located. The folders 

had ambiguous names such as Folder1 and Folder2 and the �les had names such as 

august1.docx and march2.docx.

1. Describe why Craig’s folder and �le naming system failed.

2. Craig was responsible for two areas. What folder names could he have used to make sure 

that �les could be easily located?

3. Explain why folder and �le names should be consistent, simple and meaningful.

4. Describe the consequences of placing folders and �les with unclear names in shared 

directories.

Apply security to documents

It is vital that passwords are used to 
ensure that only authorised users are able 
to access =les. Access to an organisation’s 
data can be controlled at a number 
of levels, including drives and =les. 
Employees can be given access to shared 
drives and directories or individual =les.
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Network/operating system logons

Most organisations have networks made up of more than one computer. Before 
employees can use a computer that is connected to the network they must be 
issued a logon username and password, which identi=es them and allows them to 
access the =les on the network. 

Below are some guidelines for selecting a password and for protecting your work.

Select a good password

You should change your password on a regular basis and ensure 

you do not tell anyone what it is. Your password should also not be 

anything that can be easily guessed by other people, such as your 

date of birth, name, family members’ names etc. Good passwords 

contain a mixture of letters and numbers and are at least six to 

eight characters long. Do not write your password down or keep it 

near your computer.

Protect individual �les

Depending on the network con�guration, employees will have 

their own drive for their �les along with access to various shared 

employee drives. Where information contained in �les is sensitive 

and not to be viewed by all employees, you can apply a password 

to an individual �le. Two levels of access can be applied:

 • A password to open the �le, which allows the �le to be viewed 

or printed

 • A password to modify the �le, which will let the user make 

changes to the �le

You can let any other person who needs to access the �le know 

the password.

Apply a password to a Word Ble

1. Create the document.

2. From the Ribbon, choose the File tab.

3. Click Protect Document, and choose Restrict Editing.
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4. 6e Restrict Editing sidebar will appear. Select how you wish to apply 
restrictions, then click Yes, Start Enforcing Protection.

5. A pop-up box will appear where you enter and re-enter a password.

6. Click Save.

Exit applications

A0er creating or modifying an electronic document you need to exit the so0ware 
application without causing damage or loss to the data. Data loss can occur when 
a computer program stops performing its expected function. O0en the program 
may simply appear to freeze. All computer users have experienced data loss at 
some time, or have been unable to access data from a previously functioning 
computer. Data may have been accidentally erased or corrupted and made 
inaccessible. 6ere are precautions you can take to prevent data loss. 6e main 
cause of data loss is human error. 
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Here are some other considerations to prevent data loss.

Exiting application

When �nishing work on a document you need to exit the 

application. This maintains security and frees up computer 

resources, such as memory, for other applications.

Multiple �les

Try to work on one document at a time. If you need to have 

multiple applications open, make sure you close the applications 

that are no longer needed. This will help your computer to work 

more quickly and prevent data loss if the computer fails.

Unattended workstation

Data loss can also occur if someone else tampers with your work. 

If you are working on a document at your workstation, you should 

lock your computer or exit the application before leaving your 

workstation unattended.

Software

Other causes of data loss include virus damage, operating system 

or application software bugs and failed upgrades.

Hardware

If your computer starts to make unusual noises or display warning 

messages, shut it down immediately and do not power up again 

until you have received advice from the IT coordinator.
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Practice task 20 

Read the case study, then complete the tasks that follow.

Case study

Leigh works as an of�ce administrator for a large organisation. Her daily tasks include 

modifying documents in a variety of software applications. One day she had to modify 

three documents in three different applications.

Leigh opened all three �les before starting work. While working on one document she 

went on a coffee break but left all three applications open. When Leigh returned she 

found that her computer was slower than usual and then it started to make unusual 

noises. She banged on a few keys and then on the computer. Leigh’s monitor then went 

blank.

1. Describe the mistakes Leigh made when modifying her documents.

2. Explain what work practices Leigh could have used to prevent computer failure.
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When you are assigned a task in the workplace it is important that you clarify 
when it needs to be completed. Tasks that involve the design and creation of text 
documents are no exception and it is vital that you con=rm the due date to ensure 
you can create a time line for production. 

A time line sets the schedule for a task or project. It gives details of each task 
that needs to be accomplished to achieve that goal and also describes who will 
complete each task and how long they have to do this.

Factors that can in�uence the time line for developing a document

 • Waiting to receive information from several team members to be collated 

into the one document

 • When the information is date related

 • Ensuring that resources, staff and equipment needed to produce a 

document are available and are not in use by another department

Time lines

Time lines are o0en set by other people in your organisation. To successfully meet 
these requirements, you need to de=ne the scope of the document. 6is means 
working out the range, or extent to which a document should cover its subject. To 
do this, you need to clarify who the audience is and exactly what the document 
is meant to say. 6en you need to identify the tasks involved in producing the 
document. Next, work out how long it will take you to complete each task. By 
completing each task in the time you have allocated, you should be able to produce 
the document on time.

Tasks may include:

• clarifying the document’s scope and audience

• researching the proposed content of the document

• accessing relevant information to include in the document

• writing the document

• formatting the document

• checking the document

• getting feedback on the document.

4E Prepare text documents within 
designated time lines
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Practice task 21

Read the case study, then answer the questions that follow.

Case study

Karen works as an administrative assistant. She has been asked to produce the 

organisation’s newsletter. This is usually delivered in hard copy to internal and external 

clients.

The newsletter includes reports from a number of people in different departments. It 

also includes photographs and a report that must be written by Karen about the progress 

of a current project.

Karen makes a list of everyone who has to submit work for the newsletter. She informs 

each person about the work they need to submit and when it is required. She asks a 

colleague to take the necessary photographs and have them ready one week before the 

release of the newsletter. Karen then has to write her report.

After that, she plans all of the tasks that still need to be done. She has to talk to 

colleagues involved in the project, draft and edit her report and collect reports and 

photographs from colleagues.

1. Explain why the newsletter needed a time line.

2. Comment on Karen’s planning. What do you think was good or bad about her planning?

3. When a number of people are involved in the production of a document, what things can 

go wrong?
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You will o0en experience diCculties when designing or producing documents. 
6e hardware you are using might fail or the so0ware might crash. Whatever the 
problem, it helps to have a plan for dealing with the unexpected. Organisations 
deal with diCculties in a number of diEerent ways; some might have manuals or 
training notes, others might have a help desk set up to aid employees.

You can ask for help at any time by pressing the F1 function key or clicking  on 
the right-hand side of the ribbons.

Read manuals

Most equipment and so0ware comes with a user manual. 6ese describe 
the features and provide step-by-step instructions for use. Manuals include 
information about functions, maintenance, use and WHS issues related to the 
equipment or so0ware.

Manuals can come in a paper-based or online format.

6ere are many websites that have information about Microso0 OCce 
applications. 6ese usually contain frequently asked questions (FAQs) and give 
solutions to common problems. You can also download updates, tools and any 
=xes that Microso0 has developed for its so0ware problems.

You may =nd the following websites useful.

• 6e Microso0 main site at: www.support.microso0.com can help with 
Microso0 products. You can ask questions online and download =les, 
including service packs, drivers and patches. You can also access the Microso0 
Knowledge Base.

• 6e Microso0 OCce site at: www.oCce.microso0.com provides resources for 
all OCce applications. It has news, announcements and useful =les for you to 
download. You can open this site by choosing Help, OCce on the Web in all 
OCce applications.

Read training notes

6ere are many ways to learn about computer functions and so0ware packages. 
For example, you can go on a training course to learn about particular computer 
functions. Most suppliers also provide instructions on how to use their equipment.

You may have received some training when you started your job, but it should not 
stop there. It is important to keep up-to-date with technology. Training courses 
usually provide a comprehensive set of notes that are worth keeping for future 
reference.

4F Overcome problems with document 
design and production
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Interpret error messages

Many word-processing so0ware users struggle when faced with an error message 
that includes jargon they do not understand. It is important to write down any 
error message you are presented with so that you can seek further help. It is also 
important to write down what you were doing when the error message appeared.

Here is a commonly encountered error message. 6is error is o0en encountered 
when you have created a document with the paper size set to Letter and then 
attempt to change the paper size to A4 before printing.

If you read the error carefully you can identify the settings you need to check 
in order to =x the problem: perhaps it is the margins, the column spacing or 
paragraph indents. By checking each of the settings and adjusting them as 
required you should be able to =x the problem.

If you are unable to understand a message, you could search the internet for help. 
You can search on the Microso0 OCce support sites or you can perform a general 
search using a search engine.

Tips: software help

Other sources of help for solving problems with word-processing software include:

 • accessing paper-based manuals and training booklets in your workplace

 • �nding websites that offer advice on software use

 • asking colleagues for help and advice

 • participating in training courses in your area.
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Practice task 22

Read the case study, then answer the questions that follow.

Case study

Damir is a personal assistant to the manager of a large organisation. One of his duties is 

to produce business documents using a variety of software applications. While producing 

documents Damir often needs to use the Help function to answer questions about 

software functionality. 

Sometimes Damir experiences software function problems that cannot be solved using 

the Help function and so he uses the Microsoft’s support website to �nd solutions. There 

is a paper-based manual available in his workplace and he has copied the pages that he 

needs most frequently, keeping them in a Help folder on his desk.

1. Damir sometimes has a software functionality problem. Where does he go for help?

2. Damir is sometimes puzzled by something on the screen. What does he do?

3. Describe how Damir can use the paper-based manual.

4. Do you ever experience software problems while producing a document? Describe the 

steps you usually take to solve the problem.
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Summary

1. Use advanced so0ware functions to produce documents eCciently.

2. Enter and import text to enhance your documents.

3. Editing ensures that the document is grammatically correct, has an eEective 
design and meets organisational requirements.

4. A checklist is o0en used to help people systematically go through all the points 
that need to be considered when editing a document.

5. A range of print options are available when printing a document.

6. Most organisations have folder structures and naming standards. 6is allows 
users to set up folders quickly and easily.

7. Naming methods need to be kept consistent, simple and meaningful.

8. Hard-copy documents need to be kept and archived, or destroyed a0er the 
appropriate period of time.

9. Make sure you exit applications without causing damage or data loss.

10. A time line sets the schedule for a task or project. It gives details of each task 
that needs to be accomplished to achieve that goal.

11. Time lines are o0en set by other people in your organisation. To successfully 
meet these requirements you need to de=ne the scope of the document.

12. Use online and paper-based manuals and other training materials to overcome 
problems with document design and production.
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6is learning checkpoint allows you to review your skills and knowledge in 
producing text documents.

Part A

You work for Plant Paradise. 6e business does not currently have any templates 
and you have been given the following tasks to complete. 6e company details are 
as follows:

Plant Paradise, 124 Sunhill Street, BUDERIM QLD 4556 
Ph: 07 5423 9912, Fax: 07 5423 9916 
Email: inquiries@plantparadise.com.au 
Web: www.plantparadise.com.au

1. Design a fax template.

• Use a suitable Clip Art graphic as part of the fax header.

• Ensure the paper size is A4 and set the top and bottom margins to 1 cm 
and the le0 and right margins to 2 cm.

• Save the template as ‘PP Fax Template’.

2. Create the following two-page merged document. Print the results of your 
merge and save the document used to create the merge as ‘Faxed Myer’.

Page 1

• Using a document based on the fax template you just developed create the 
following fax.

Dear <First Name>,

We are pleased to send you our Summer Specials Myer. We have a number 
of new products available this summer and have featured some of them on 
the Myer.

Be sure to purchase your seed early so you can ensure your plants are 
established before the summer heat arrives.

6is month all orders over $70 receive a free packet of Grow Now organic 
plant booster.

If you do not wish to receive these faxes in future, please contact this oCce 
on 07 5423 9912 to be removed from the mailing list.

Please do not hesitate to give our friendly team a call if you need any 
further information.

Happy gardening!

6e Plant Paradise team

Learning checkpoint 4 
Produce text documents
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Recipient data:

First name Surname Fax number

Wafah Dafour 07 5423 0987

Jacob Shelby 07 3645 0978

Vladimir Klimovitch 07 4164 5632

Ryan Wheelan 07 5419 0088

Charlotte Johnson 07 4162 3277

Page 2

• On the second page of the same document create a Myer containing the 
specials information shown below.

• Ensure you create a professional design that adheres to design principles 
outlined in Topic 2.

3. Insert the pictures of the fruits and vegetables into the Myer from plant-
paradise-images.docx. Access and download this by either scanning the QR 
code provided or at: http://chilp.it/6b8c562.

• 6e Myer should be on A4 paper, have a border and the margins 
should be 1 cm on all sides. Do not change the margins on the 
fax cover sheet.

• Ensure you include the company name, phone number and 
website address on the Myer.

Summer Specials

Sweet corn

Sweet corn fresh from the garden is one of summer’s great treats. Sweet corn 
should be planted in blocks of several rows close together for best pollination. 
Single-row plantings can result in poor kernel set. Pick and use immediately 
for maximum sweetness.

Pumpkin

6ese summer favourites come in a huge range of varieties. 6ey are easy to 
grow, and love heat and regular water. Varieties available include Butternut, 
Jarradale, Ken Special and Queensland Blue. For best results plant on small 
mounds in groups of three.

Elderberry (new)

6is easy-to-grow clumping tree has attractive white Mowers followed by dark 
purple berries. Harvest the berries to make a tangy jam. Berries can also be 
used to produce either sparkling or still wine.
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Purple runner beans (new)

6ese large, hardy beans will thrive during the heat of summer. 6ey bene=t from 
regular deep watering. Keep well-mulched for best results.

Passionfruit

6e bright-green leaves and pretty Mowers make passionfruit a perfect choice for 
covering a fence. Fertilise and water regularly. Fruit can be harvested when it falls 
from the vine when touched gently.

Rosella

Remember grandma’s rosella jam? Surprisingly easy to grow, rosellas add a 
fantastic splash of colour to the garden with their dark green leaves and bright 
red pods. Great disease resistance. Water occasionally and pick frequently for best 
results.

Part B

Read the case study, then complete the task that follows.

Case study

You work for Johnson’s Motors, a car dealership that sells and services Toyota and 

Suzuki vehicles. A new computer system has just been installed and you have been 

asked to create a directory structure that will meet their needs. It is important that they 

keep the information for Toyotas and Suzukis separate. They need to store the following 

information for each make of vehicle:

 • Sales

 • Servicing

 • Marketing

They also need to store electronic �les on employees, advertised positions and 

accounting data.

Design a folder structure to suit Johnson’s Motors. Make sure you choose names 
that are consistent, simple and meaningful.
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Part C

Shown below is an edited document. Access and download laser-printer-purchase.
docx by either scanning the QR code or at: http://chilp.it/6e9bd54. Make the 
changes below. Save the document as ‘Edited report’ and print a copy.

Part D

Using the methods discussed in this topic, =nd help on the following Word issues. 
Print the information you =nd or write down the instructions to hand in to your 
trainer.

• Printing a list of AutoCorrect entries that have been created

• Bottom border on page won’t print

• Change the language from English (US) to English (Australian)
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Part E

Create a business document such as a report, Myer or newsletter. 6e topic is up to 
you, but you must discuss it with your trainer before you start.

If you are a workplace learner, you may use documents from your business. You 
will need to speak with your supervisor to decide on a suitable document.

1. Record the following information.

• 6e purpose and audience of the document

• 6e tasks that need to be completed to produce the document

• 6e time line for the document’s production, showing the amount of time 
required for each task

2. Create the document.

• Print a dra0 of the document and edit it. (Submit the dra0 showing your 
editing with the =nal document.)

• Make the amendments to the document.

• Save the document with a suitable name.

• Print the =nal document.

3. Describe any diCculties you experienced when producing the document and 
explain how they were overcome.


	Contents
	Before you begin
	Topic 1 Prepare to produce word‑processed documents
	1A Use safe work practices
	1B Identify and clarify the purpose, audience and presentation requirements of a document
	1C Identify requirements to ensure consistency of style and image
	Summary
	Learning checkpoint 1 Prepare to produce word-processed documents

	Topic 2 Design word-processed documents
	2A Design the structure and layout of a document
	2B Design the document to enhance readability and appearance
	2C Ensure consistency of design and layout
	Summary
	Learning checkpoint 2 Design word-processed documents

	Topic 3 Add tables and other data
	3A Insert a standard table into a document
	3B Insert and delete columns and rows
	3C Insert images and other data
	Summary
	Learning checkpoint 3 Add tables and other data

	Topic 4 Produce text documents
	4A Use advanced software functions
	4B Enter, import and edit text and other data
	4C Preview, adjust and print documents
	4D Name and store text documents and exit the application safely
	4E Prepare text documents within designated time lines
	4F Overcome problems with document design and production
	Summary
	Learning checkpoint 4 Produce text documents


